# Model 3068B Aerosol Electrometer

## User’s Manual

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product Overview</td>
<td>1</td>
</tr>
<tr>
<td>Unpacking and Setting Up the System</td>
<td>2</td>
</tr>
<tr>
<td>Controls, Indicators, and Connectors</td>
<td>3</td>
</tr>
<tr>
<td>Operating the Aerosol Electrometer</td>
<td>4</td>
</tr>
<tr>
<td>Aerosol Instrument Manager® Software</td>
<td>5</td>
</tr>
<tr>
<td>Maintenance</td>
<td>6</td>
</tr>
<tr>
<td>Troubleshooting</td>
<td>7</td>
</tr>
<tr>
<td>Contacting Customer Service</td>
<td>8</td>
</tr>
<tr>
<td>Appendixes</td>
<td></td>
</tr>
</tbody>
</table>
The following is a manual history of the Model 3068B Aerosol Electrometer (Part Number 1930077).

<table>
<thead>
<tr>
<th>Revision</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>May 2006</td>
</tr>
</tbody>
</table>
Warranty

Part Number 1930077 / Revision A / May 2006
Copyright ©TSI Incorporated / 2006 / All rights reserved.
Address TSI Incorporated / 500 Cardigan Road / Shoreview, MN 55126 / USA
E-mail Address particle@tsi.com

Limitation of Warranty and Liability
(effective July 2000)

Seller warrants the goods sold hereunder, under normal use and service as described in the operator’s manual, shall be free from defects in workmanship and material for (12) months, or the length of time specified in the operator’s manual, from the date of shipment to the customer. This warranty period is inclusive of any statutory warranty. This limited warranty is subject to the following exclusions:

a. Hot-wire or hot-film sensors used with research anemometers, and certain other components when indicated in specifications, are warranted for 90 days from the date of shipment.

b. Parts repaired or replaced as a result of repair services are warranted to be free from defects in workmanship and material, under normal use, for 90 days from the date of shipment.

c. Seller does not provide any warranty on finished goods manufactured by others or on any fuses, batteries or other consumable materials. Only the original manufacturer’s warranty applies.

d. Unless specifically authorized in a separate writing by Seller, Seller makes no warranty with respect to, and shall have no liability in connection with, goods which are incorporated into other products or equipment, or which are modified by any person other than Seller.

The foregoing is IN LIEU OF all other warranties and is subject to the LIMITATIONS stated herein. NO OTHER EXPRESS OR IMPLIED WARRANTY OF FITNESS FOR PARTICULAR PURPOSE OR MERCHANTABILITY IS MADE.

TO THE EXTENT PERMITTED BY LAW, THE EXCLUSIVE REMEDY OF THE USER OR BUYER, AND THE LIMIT OF SELLER’S LIABILITY FOR ANY AND ALL LOSSES, INJURIES, OR DAMAGES CONCERNING THE GOODS (INCLUDING CLAIMS BASED ON CONTRACT, NEGLIGENCE, TORT, STRICT LIABILITY OR OTHERWISE) SHALL BE THE RETURN OF GOODS TO SELLER AND THE REFUND OF THE PURCHASE PRICE, OR, AT THE OPTION OF SELLER, THE REPAIR OR REPLACEMENT OF THE GOODS. IN NO EVENT SHALL SELLER BE LIABLE FOR ANY SPECIAL, CONSEQUENTIAL OR INCIDENTAL DAMAGES. SELLER SHALL NOT BE RESPONSIBLE FOR INSTALLATION, DISMANTLING OR REINSTALLATION COSTS OR CHARGES. No Action, regardless of form, may be brought against Seller more than 12 months after a cause of action has accrued. The goods returned under warranty to Seller’s factory shall be at Buyer’s risk of loss, and will be returned, if at all, at Seller’s risk of loss.

Buyer and all users are deemed to have accepted this LIMITATION OF WARRANTY AND LIABILITY, which contains the complete and exclusive limited warranty of Seller. This LIMITATION OF WARRANTY AND LIABILITY may not be amended, modified or its terms waived, except by writing signed by an Officer of Seller.

Service Policy

Knowing that inoperative or defective instruments are as detrimental to TSI as they are to our customers, our service policy is designed to give prompt attention to any problems. If any malfunction is discovered, please contact your nearest sales office or representative, or call TSI at 1-800-874-2811 (USA) or (651) 490-2811.
# Contents

Manual History ................................................................. iv
Warranty............................................................................. v
Safety ................................................................................... xiii
Labels .................................................................................. xiii
Description of Caution Symbol ........................................... xv
Caution............................................................................... xv
Warning............................................................................. xv
Caution or Warning Symbols............................................. xvii
About This Manual ........................................................... xvii
Purpose.............................................................................. xviii
How This Manual is Organized.......................................... xviii
Notations/Conventions Used in This Manual ..................... xviii
Related Product Literature ............................................... xviii
Getting Help........................................................................ xix
Submitting Comments ..................................................... xix

## CHAPTER 1 Product Overview ........................................ 1-1
  Product Description ....................................................... 1-1
  Software........................................................................... 1-2
  Electrometer Current and Calculated Particle
  Concentration .................................................................. 1-3

## CHAPTER 2 Unpacking and Setting Up the System ............ 2-1
  Packing List ....................................................................... 2-1
  Unpacking Instructions.................................................... 2-1
  Moving the Instrument..................................................... 2-2
  Mounting the Instrument .................................................. 2-2
  Power Connection ............................................................ 2-2
  Connecting to Vacuum...................................................... 2-3
  Connecting to the Aerosol Source .................................... 2-3
  Connecting to the Computer ............................................ 2-4
  Analog Output.................................................................... 2-4
  Optional Accessories ...................................................... 2-5

## CHAPTER 3 Controls, Indicators, and Connectors ............. 3-1
  Front Panel ....................................................................... 3-1
  Keypad, Display and Menu Navigation ............................ 3-2
  Indicator Lights ............................................................... 3-3
  Back Panel ....................................................................... 3-4
  AC Power Connector and On/Off Switch ......................... 3-4
  Serial Port ....................................................................... 3-4
  USB Port .......................................................................... 3-4
CHAPTER 4 Operating the Aerosol Electrometer ............ 4-1
Front Panel Controls ...................................................... 4-1
To Start Measurement ..................................................... 4-1
To View or Configure User Settings ............................... 4-2
To View Instrument Status ........................................... 4-3
Computer Control ......................................................... 4-4
Using Aerosol Instrument Manager® Software .................. 4-4
Using Other Software .................................................... 4-4

CHAPTER 5 Aerosol Instrument Manager® Software ....... 5-1
Installation Requirements .............................................. 5-1
Installation .................................................................... 5-2
Getting Started .............................................................. 5-3
Start the Program ......................................................... 5-3
Open an Existing File .................................................... 5-4
Change How Data is Viewed ....................................... 5-5
View Another Sample in the Same File ....................... 5-6
Playback (Review) Data Samples ................................. 5-6
Select a Data Hot Spot .................................................. 5-8
Delete/Undelete Samples .......................................... 5-9
Zoom In and Out on Data in a Graph ......................... 5-9
Print Information Displayed on the Desktop ............. 5-10
Export Data to a File .................................................... 5-11
Arrange Open Windows ............................................. 5-12
Quit the Program ......................................................... 5-13
Software Procedures .................................................... 5-14
How to Set Up Instrument Properties ......................... 5-14
How To Collect Sample Data ........................................ 5-19
Software Menus ......................................................... 5-20
Desktop Menus .......................................................... 5-21
Context-Sensitive Menus ............................................. 5-38
Status Bar Icons ........................................................ 5-43

CHAPTER 6 Maintenance ............................................... 6-1
Calibration and Performance ....................................... 6-1
Periodic Maintenance .................................................. 6-1
Replacing the Filter Cartridge and Cleaning the Electrometer ...................................................................... 6-2
Checking the Flowmeter ............................................... 6-4
Testing for Leaks .......................................................... 6-4
Isolating Leaks .............................................................. 6-5

CHAPTER 7 Troubleshooting ........................................... 7-1
Error Handling .............................................................. 7-1
Noisy Electrometer Output ........................................ 7-2
Unstable Zero Offset Level .......................................... 7-3
Tables

2-1 Aerosol Electrometer Packing List .........................................2-1
3-1 Menu Structure and Navigation Path ........................................3-2
5-1 Descriptions of Scheduling Parameters for an Aerosol
   Electrometer ........................................................................5-15
5-2 Descriptions of Settings Parameters for an Aerosol
   Electrometer ........................................................................5-17
5-3 Descriptions for the Communications Tab..............................5-19
5-4 Samples List View Popup Menu..............................................5-39
5-5 View Popup Menu ...............................................................5-41
5-6 Graph View Popup Menu......................................................5-41
5-7 Statistics View Popup Menu..................................................5-43
6-1 Maintenance Schedule ..........................................................6-1
A-1 Specifications* of the 3068B Aerosol Electrometer..............A-1
D-1 Signal Connections for RS-232 Configurations.....................D-1
H-1 Error Messages for Aerosol Electrometer ..............................H-1
Safety

This section gives instructions to promote safe and proper handling of the Model 3068B Aerosol Electrometer.

There are no user-serviceable parts inside the instrument. Refer all repair and maintenance to a qualified technician. All maintenance and repair information in this manual is included for use by a qualified technician.

To prevent problems, take these precautions:

- Do not remove any parts from the instrument unless you are specifically told to do so in this manual.
- Do not remove the instrument housing or covers while power is supplied to the instrument.

<table>
<thead>
<tr>
<th>Caution</th>
</tr>
</thead>
<tbody>
<tr>
<td>If the Model 3068B is used in a manner not specified by the manufacturer, the protection provided by the equipment may be impaired.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Warning</th>
</tr>
</thead>
<tbody>
<tr>
<td>High-voltage is accessible in several locations within this instrument. Make sure you unplug the power source before removing the cover or performing maintenance procedures.</td>
</tr>
</tbody>
</table>

Labels

The Aerosol Electrometer has six labels shown in Figure S-1, Figure S-2, and Figure S-3. They are described below.

1. High-Voltage Symbol Label
   (interior bottom left—on power entry module)

2. Ground Symbol Label
   (interior bottom left—next to ground stud)

3. High-Voltage Symbol Label
   (interior left—on power supply)

4. Serial Number Label (back of cabinet)
5  Caution, No Serviceable Parts Label (back of cabinet)
6  Customer Service Label (back of cabinet)

**Figure S-1**
Location of High Voltage Symbol Labels and Ground Label

**Figure S-2**
Location of High Voltage Label on the Power Supply Module
Description of Caution Symbol

The following symbol and an appropriate caution statement are used throughout the manual and on the Model 3068B to draw attention to any steps that require you to take cautionary measures when working with the Model 3068B:

Caution

| Caution | Caution means be careful. It means if you do not follow the procedures prescribed in this manual you may do something that might result in equipment damage, or you might have to take something apart and start over again. It also indicates that important information about the operation and maintenance of this instrument is included. |

Warning

| Warning | Warning means that unsafe use of the instrument could result in serious injury to you or cause irrevocable damage to the instrument. Follow the procedures prescribed in this manual to use the instrument safely. |
Caution or Warning Symbols

The following symbols may accompany cautions and warnings to indicate the nature and consequences of hazards:

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>⚡️</td>
<td>Warns you that uninsulated voltage within the instrument may have sufficient magnitude to cause electric shock. Therefore, it is dangerous to make any contact with any part inside the instrument.</td>
</tr>
<tr>
<td>⚡️‖</td>
<td>Indicates the connector is connected to earth ground and cabinet ground.</td>
</tr>
</tbody>
</table>
About This Manual

Purpose

This is an instruction manual for the operation and handling of the Model 3068B Aerosol Electrometer and for the Aerosol Instrument Manager® Software as it applies to Aerosol Electrometer.

How This Manual is Organized

This manual describes the Aerosol Electrometer and the Aerosol Instrument Manager software for the Aerosol Electrometer and includes information such as:

- The manual starts with a product overview and introduction.
- There is information about unpacking and setting up the system and a description of controls, indicators, and connectors.
- Operating the Aerosol Electrometer
- Requirements for loading and running the software.
- The installation procedure that loads the program onto your computer.
- A “Getting Started” chapter that introduces basic software operation.
- “How to...” information for using the program to operate and collect data with an aerosol electrometer.
- Descriptions of the menus and menu items that are valid when collecting data with an aerosol electrometer.
- Appendixes that provide reference information associated with instrument and program operation.
Notations/Conventions Used in This Manual

- Throughout this manual when reference is made to "Windows," it implies Windows® 2000 or Windows® XP operating system.
- Bold face type is used to indicate that you should perform the indicated action. For example “select the File menu” means that you should use the mouse and click on the menu called File.
- When instructions direct you to select items from a menu, a vertical bar (|) is used to separate the items you should select. For example, "select File | Properties | Settings" means you should click on the File menu, then select the Properties item, and then select the Settings tab.
- The term “active window” is used to refer to the window that is open on the desktop and is in focus. To verify which window is active, select the Window menu and note which item has a checkmark by it. You can make a window active by moving the pointer to that window and clicking the mouse button.

Related Product Literature

- Model 3080 Electrostatic Classifier Manual (part number 1933792 TSI Incorporated)
- Model 3772/3771 Condensation Particle Counter (part number 1980529 TSI Incorporated)
- Model 3775 Condensation Particle Counter (part number 1980527 TSI Incorporated)
- Model 3776 Ultrafine Condensation Particle Counter (part number 1980522 TSI Incorporated)
Getting Help

To obtain assistance with this product or to submit suggestions, please contact TSI Particle Instruments:

TSI Incorporated
500 Cardigan Road
Shoreview, MN 55126 U.S.A.
Fax: (651) 490-3824
Telephone: 1-800-874-2811 (USA) or (651) 490-2811
E-mail: technical.service@tsi.com
Web site: www.tsi.com

Submitting Comments

TSI values your comments and suggestions on this manual. Please use the comment sheet, on the last page of this manual, to send us your opinion on the manual's usability, to suggest specific improvements, or to report any technical errors.

If the comment sheet has already been used, send your comments to:

Particle Instruments
TSI Incorporated
500 Cardigan Road
Shoreview, MN 55126 U.S.A.
Fax: (651) 490-3824
E-mail Address: particle@tsi.com
Web site: www.tsi.com
CHAPTER 1
Product Overview

This chapter describes the Model 3068B Aerosol Electrometer, shown in Figure 1-1, and gives an overview of how this instrument works.

Product Description

The Model 3068B Aerosol Electrometer (Figure 1-1) provides accurate and sensitive measurements of the total net charge on aerosol particles. If the particle charge distribution is known, particle concentration can be calculated from the charge measurement accurately. This instrument can be used to measure the output of instruments such as the TSI Model 3080 Electrostatic Classifier. It can also be used to measure the charged particles directly from aerosol sources.

Figure 1-1
Model 3068B Aerosol Electrometer

When paired with a TSI Electrostatic Classifier, the Aerosol Electrometer measures the number concentration of monodisperse
aerosol. This configuration is used primarily for calibrating and testing particle instruments like Condensation Particle Counters and other sub-micron particle counters or sizers. This system is called a “primary” method of generating “monodisperse” aerosol and measuring its concentration, because it depends only on basic measurements such as flow rate, voltage, and current.

The Model 3068B Aerosol Electrometer has been updated from the TSI Model 3068A Electrometer to significantly improve performance and provide a state-of-the-art user and computer interface. Compared to other electrometers, it has a large dynamic range with no range switching necessary. It also includes temperature stabilization circuitry that allows it to have very low temperature drift over its operational temperature range. The noise level of this electrometer is better than 1 femptoAmp (fA) root mean square (RMS) with a one second averaging time.

The Model 3068B Electrometer has a built-in thermal flowmeter and proportional solenoid valve controlled by a microprocessor. This configuration allows the user specified aerosol sample rate to be controlled in the range of 0.3–10 liters per minute (L/min).

Data are presented on the front-panel display, as an analog voltage output, or through the RS-232 serial or USB interfaces. The electrometer is supported by the Aerosol Instrument Manager® software to allow data to be collected, stored and manipulated.

Software

The Aerosol Instrument Manager® software is used to collect sample data from a sensor and store the sample data in files. You can use the software to display data in graphs and tables, or view statistical information. You can print graphs and tables with the software, and export data for use in other applications.

There are a number of ways to navigate within the program. These include selecting items from the main menus, selecting icons from the toolbar, and selecting items from submenus (which you access by right-clicking the mouse button). Specific instructions are provided in the following chapters.

This manual covers the use of the Aerosol Instrument Manager software with TSI model 3068B Aerosol Electrometer sensors only. For information about software operation with other TSI sensors, refer to the appropriate manual.
Electrometer Current and Calculated Particle Concentration

Data is collected from the instrument and may be displayed as either electrometer current or calculated particle concentration (#/cm³) every second and averaged for each averaging interval. The particle concentration is based on a user-entered value for average charge.

This manual assumes you have Microsoft® Windows® 2000 or Windows® XP operating system on your computer and that you are familiar with how Windows works. If you are not familiar with Windows, please refer to the information that came with it before you load and use this program.
CHAPTER 2

Unpacking and Setting Up the System

Use the information in this chapter to unpack and setup the Model 3068B Aerosol Electrometer.

Packing List

As you unpack the shipping container, make certain the shipment is complete. Table 2-1 gives a packing list for the Electrometer.

Table 2-1
Aerosol Electrometer Packing List

<table>
<thead>
<tr>
<th>Qty</th>
<th>Description</th>
<th>Part No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Model 3068B Aerosol Electrometer</td>
<td>306810</td>
</tr>
<tr>
<td>1</td>
<td>Power cord 100–120 VAC</td>
<td>1303053*</td>
</tr>
<tr>
<td>1</td>
<td>Cable, 9-pin serial M-F (12 feet)</td>
<td>962002</td>
</tr>
<tr>
<td>1</td>
<td>USB Cable, I/O, A/B</td>
<td>1303740</td>
</tr>
<tr>
<td>1</td>
<td>Filter, wire core microfiber</td>
<td>1602346</td>
</tr>
<tr>
<td>10 in</td>
<td>TU Tygon 2057 Butyl 0.312 OD x 0.187 ID</td>
<td>3900030</td>
</tr>
<tr>
<td>12 ft</td>
<td>¼ inch polyflo tubing</td>
<td>3929408</td>
</tr>
<tr>
<td>1</td>
<td>Union Compression fitting</td>
<td>1601052</td>
</tr>
<tr>
<td>1</td>
<td>User’s manual</td>
<td>1930077</td>
</tr>
<tr>
<td>1</td>
<td>Aerosol Instrument Manager Software</td>
<td>390065</td>
</tr>
</tbody>
</table>

*Power cord listed is for U.S.A. use only. Appropriate power cord will be provided for different regions.

Unpacking Instructions

The Model 3068B is shipped fully assembled. To begin using the instrument:

1. Remove the protective caps from the Sample Inlet, the External Vacuum, the BNC connector and the serial port. The caps should be saved for leak-checking use or whenever packing the instrument for shipment.

2. Insert the appropriate power cord into the back of the instrument and turn it on using the switch next to the power entry port.
**Moving the Instrument**

The Model 3068B Aerosol Electrometer is small and light enough that it can be easily moved by gripping the bottom of the instrument on both sides and lifting.

**Mounting the Instrument**

The Aerosol Electrometer has no special mounting requirements other than providing enough space around the cabinet for heat dissipation by the cooling fan. Allow at least one inch (2.5cm) clearance on either side of the cabinet for adequate cooling. The cabinet has four non-marking rubber feet that give the instrument a good grip on clean, level surfaces. The rubber feet are installed in the cabinet using integrated #8-32 UNC threaded fasteners and can be removed (by unscrewing) to allow other mounting fasteners to be used.

**Power Connection**

Connect the AC power cord (supplied) to the AC Power In connection on the back of the Electrometer and then into an available power outlet. The instrument accepts line voltage 100 to 240 VAC, 50/60 Hz, 160 W maximum single phase. The connector has a built-in on/off switch.

**Notes:** Make certain the line cord is plugged into a grounded (earth grounded) power outlet. Position the Electrometer so the power cord connector is not blocked and is easily accessible.

The Electrometer power supply contains no user-serviceable parts. If the power supply is not operating correctly, use the information in Chapter 8 to contact TSI. This instrument should not be used in a manner not specified by the manufacturer.

Toggle the power switch to the on position to verify the instrument has power.
Connecting to Vacuum

The Aerosol Electrometer is designed to operate with sampling rates up to 10 L/min. The Model 3068B has a built-in automatic proportional control valve controlled by a microprocessor and a TSI 4140 Flowmeter to measure and control flow over the range of 0.3-10 L/min. The pressure drop across the instrument is about 114 cm (45 in.) of water at a flow rate of 10 L/min. For laboratory use, the system can often be connected directly to an existing vacuum source in the laboratory. If this is not feasible, use a TSI Model 3033 Vacuum Pump or Gast Model 0522 oil-less vacuum pump for this purpose. Avoid piston or diaphragm pumps because they produce pulsing flow that causes greater measurement errors. Rigid tubing (P/N 3929408) and a union compression fitting (P/N 1601052) are provided in the accessory kit to connect the vacuum port on the Aerosol Electrometer to a vacuum system or pump.

Note: Automatic flow control is provided for flexibility. However, the instrument uses a volumetric flowmeter. Due to the pressure drop through the electrometer filter, the accuracy of the flow control is limited to 2% up to 2 L/min and 5% up to 10 L/min. More accurate flow control (and therefore a more accurate measurement) is possible by setting the flow control to manual mode and using an external needle valve or critical orifice to control the flow.

WARNING

Do not apply a vacuum to the Sample Inlet. A flow in the reverse direction can potentially damage the small poppet inside the solenoid valve.

Connecting to the Aerosol Source

Connect the Sample Inlet to the aerosol source. Make sure that the inlet pressure is higher than the outlet pressure so that the flow is not in the reverse direction. This instrument has been tested in the pressure range from 25% below to 25% above one atmosphere. Contact TSI if you want to operate the Electrometer at pressures out of this range.
Connecting to the Computer

The Electrometer provides a standard RS-232 serial port and a USB port to allow for flexible data collection and instrument control. The user can connect the Electrometer to a computer (computer must be using Microsoft® Windows® operating system) in either of two ways (Figure 2-1):

- Connect the serial port of a computer to the Serial connector on the back of the Model 3068B. Use the 4-meter cable provided. If you need a longer cable, use a standard 9-pin, serial extension cable.

- Connect a USB port of a computer to the USB port on the back of the Model 3068B. USB driver software is installed on the host computer when you install the Aerosol Instrument Manager software.

Analog Output

The Electrometer has a single-channel analog output BNC connector labeled Analog Output. This port can be easily configured through the “user settings” menu on the front panel (see Chapter 4) or by serial commands (see Appendix D) to provide a variety of output ranges.

©Microsoft and Windows are registered trademarks of Microsoft Corporation.
Note: The analog port is provided for backward compatibility with older electrometers. The resolution is limited to 16-bit. It is much more accurate to use the digital (USB or Serial) ports.

Optional Accessories

The Aerosol Electrometer can be used together with the Model 3080 Electrostatic Classifier. The Electrostatic Classifier can be used for generating monodisperse aerosol of known size and charge. With a user-defined average charge the electrometer results can be displayed as number concentrations.
CHAPTER 3
Controls, Indicators, and Connectors

Use the information in this chapter to familiarize yourself with the location and function of controls, indicators, and connectors on the Model 3068B Aerosol Electrometer.

This chapter is organized into two sections describing the front and back panels of the instrument.

Front Panel

The main components of the front panel are a keypad with six (6) keys, a display, and two LED indicators (see Figure 3-1).

Figure 3-1
Front of the Model 3068B Aerosol Electrometer
Keypad, Display and Menu Navigation

As shown in Figure 3-2, the keypad has six keys: scroll left left, scroll right right, scroll up up, scroll down down, Enter Enter, and ESC ESC. You can set up operating parameters via the keypad as well as serially through the computer.

The display is a 2-line by 16-character alphanumeric display (Figure 3-2). It shows information on measurement results, menu options or error messages.

![Figure 3-2](image)

Keypad and Display

The menu structure of the Electrometer Model 3068B is divided into three different levels. The user can navigate the menu options using the keypad. The menu structure and navigation path are shown in Table 3-1. Detailed navigation instruction will be described in Chapter 4. Briefly,

- The menus go from a lower to a higher menu level using the left or right key and from a higher to a lower menu level using the ESC key.
- Menus are rolled through using the up and down arrow keys.
- The user settings are selected using the left and right arrow keys. The new setting becomes active immediately. If you press ESC before hitting the enter key, the settings are not changed.

<table>
<thead>
<tr>
<th>Menu Level</th>
<th>Description</th>
<th>Up</th>
<th>Down</th>
<th>Left</th>
<th>Right</th>
<th>Enter</th>
<th>Escape</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Warm up on power-up</td>
<td>Primary</td>
<td>Primary</td>
<td>Primary</td>
<td>Primary</td>
<td>Primary</td>
<td>Primary</td>
</tr>
<tr>
<td>1</td>
<td>Primary display mode</td>
<td>User Settings</td>
<td>Secondary</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Secondary display Mode</td>
<td>Primary</td>
<td>Status</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Status</td>
<td>Secondary</td>
<td>Primary</td>
<td></td>
<td></td>
<td>Aerosol T</td>
<td>Primary</td>
</tr>
<tr>
<td>2</td>
<td>Aerosol Temp</td>
<td>Firmware</td>
<td>Aerosol P</td>
<td></td>
<td></td>
<td></td>
<td>Status</td>
</tr>
<tr>
<td>2</td>
<td>Aerosol Pressure</td>
<td>Aerosol T</td>
<td>Ambient P</td>
<td></td>
<td></td>
<td></td>
<td>Status</td>
</tr>
<tr>
<td>Menu Level</td>
<td>Description</td>
<td>Up</td>
<td>Down</td>
<td>Left</td>
<td>Right</td>
<td>Enter</td>
<td>Escape</td>
</tr>
<tr>
<td>------------</td>
<td>------------------------------</td>
<td>-------------------</td>
<td>-------------------</td>
<td>------</td>
<td>-------</td>
<td>-----------</td>
<td>--------</td>
</tr>
<tr>
<td>2</td>
<td>Ambient Press</td>
<td>Aerosol P</td>
<td>Cabinet T</td>
<td></td>
<td></td>
<td></td>
<td>Status</td>
</tr>
<tr>
<td>2</td>
<td>Cabinet Temp</td>
<td>Ambient P</td>
<td>Valve Duty Cycle</td>
<td></td>
<td></td>
<td></td>
<td>Status</td>
</tr>
<tr>
<td>2</td>
<td>Valve Duty Cycle</td>
<td>Cabinet T</td>
<td>USB Status</td>
<td></td>
<td></td>
<td></td>
<td>Status</td>
</tr>
<tr>
<td>2</td>
<td>USB Status</td>
<td>Valve Duty Cycle</td>
<td>Zero Offset</td>
<td></td>
<td></td>
<td></td>
<td>Status</td>
</tr>
<tr>
<td>2</td>
<td>Zero Offset</td>
<td>USB Status</td>
<td>Firmware Version</td>
<td></td>
<td></td>
<td></td>
<td>Status</td>
</tr>
<tr>
<td>2</td>
<td>Firmware Version</td>
<td>Zero Offset</td>
<td>Aerosol T</td>
<td></td>
<td></td>
<td></td>
<td>Status</td>
</tr>
<tr>
<td>1</td>
<td>User Settings</td>
<td>Status</td>
<td>Primary</td>
<td></td>
<td></td>
<td>Flow Control</td>
<td>Primary</td>
</tr>
<tr>
<td>2</td>
<td>Flow Control</td>
<td>Electrometer Zero</td>
<td>Flow Setting</td>
<td></td>
<td></td>
<td>Toggle On/Off/Manual</td>
<td>Settings</td>
</tr>
<tr>
<td>2</td>
<td>Average Charge / Particle</td>
<td>Flow Setting [Edit – Increase]</td>
<td>Analog Output [Edit – Decrease]</td>
<td>Move cursor among digits</td>
<td>Save Setting</td>
<td>Settings</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Analog Output</td>
<td>Average Charge</td>
<td>Data Average</td>
<td></td>
<td></td>
<td>Choose one range</td>
<td>Settings</td>
</tr>
<tr>
<td>2</td>
<td>Data Average Time</td>
<td>Analog Output</td>
<td>Electrometer Zero</td>
<td></td>
<td></td>
<td>Choose one value</td>
<td>Settings</td>
</tr>
<tr>
<td>2</td>
<td>Electrometer Zero</td>
<td>Data Average</td>
<td>Flow Control</td>
<td></td>
<td></td>
<td>New average zero value</td>
<td>Settings [Abort]</td>
</tr>
</tbody>
</table>

**Indicator Lights**

Two indicator lights above the display on the front panel provide a quick indication of the Electrometer’s current operating status.

**Power**

A steady glow of the power light indicates that the instrument is powered on. The power light goes off when the power to the Electrometer is shut off.

**Status**

A steady glow of the status light indicates that the instrument has warmed to its operating temperature and the user-specified flow is achieved. The light will blink in one of the following situations:

- The flow rate is not within ±10% of the specified value or if it is in manual control mode.
- The cabinet or aerosol temperature is greater than 50°C or less than 0°C.
- The flat cable to the sensor is disconnected (see Figure 7-1).
Back Panel

As shown in Figure 3-3, the back panel has a USB, a serial, and an analog output port, an external vacuum tube, a sample inlet, a filter access cover, a power connection and an on/off switch.

AC Power Connector and On/Off Switch

The AC power connector accepts the line cord (supplied) to provide AC power to the instrument. See “Power Connection” in Chapter 2 for more information. The on/off switch turns the aerosol electrometer on or off.

Serial Port

The Electrometer has a single RS-232 serial port that can be used to communicate with a computer using a standard 9-pin serial cable. See Appendix D, “Serial Commands” for a detailed explanation.

Note: If both RS-232 and USB are connected, the USB will be automatically used.

USB Port

The USB (Universal Serial Bus) port provides an interface to communicate with a computer using TSI software. See section
“Using Aerosol Instrument Manager® Software” in Chapter 4. This port is USB version 2.0 compatible and supports full speed mode.

**Note:** Connecting the USB disables the RS-232 communications.

**Analog Out**

The Analog Output is a BNC connector that can be configured to provide a 0-10 V output corresponding to one of the following aerosol current ranges (note that 1 pA equals 1000 fA):

- -12.5 to +12.5 pA
- -1.0 to +1.0 pA
- 0 to -12.5 pA
- 0 to -10.0 pA
- 0 to -1.0 pA
- 0 to -0.1 pA
- 0 to +0.1 pA
- 0 to +1.0 pA
- 0 to +10.0 pA
- 0 to +12.5 pA.
- OFF

**Note:** The analog port is provided for backward compatibility with older electrometers. The resolution is limited to 16-bit. It is much more accurate to use the digital (USB or Serial) ports.

For more information, see Appendix D, “Serial Commands.”

**Aerosol Inlet**

The aerosol inlet samples 0.3 to 10 L/min of aerosol from ambient air. It can also be connected to tubing for sampling. If sampling tubing is used, it should be conductive or static dissipative to reduce particle losses.

**External Vacuum Tubing**

The external vacuum tubing on the back of the Electrometer is a ¼-inch stainless steel tube. This tube should be connected to an external vacuum source such as a pump or a vacuum line using tubing that will not collapse under vacuum such as the tubing (P/N 3929408) and union compression fitting (P/N 1601052) provided in the accessory kit.
Filter Access Cover

The metal plate that contains the sample inlet serves as the Filter Access Cover. The access cover allows the electrometer filter to be replaced without having to remove the instrument cover. See Chapter 6, “Maintenance,” for more information.
CHAPTER 4
Operating the Aerosol Electrometer

This chapter describes how to operate the Model 3068B Aerosol Electrometer either through front panel controls or computer control.

Front Panel Controls

To control what is displayed on the front panel, to check instrument status and to control some of the functions of the Aerosol Electrometer can all be done from the front panel using the front panel controls. The sections below describe how to perform some of these functions.

To Start Measurement

1. Supply power to the Aerosol Electrometer by plugging the AC power cord into the power cord inlet on the back panel and then into an AC source. Switch on the power switch next to the power cord inlet. It will typically take 10 minutes to warm up when the power is switched on, with the display showing the warming up message. Pressing any button on the front panel will eliminate the warm up message but full stability requires approximately 10 minutes. The instrument will configure itself according to the state it was in when last powered off.

2. Connect a vacuum source (TSI Model 3033 Vacuum Pump, or equivalent) to the External Vacuum connector.

3. Choose one of the three options below

   a. If the instrument has been previously configured and there is no need to change the configuration, connect the aerosol source to the Sample Inlet connector and start measurement when the instrument is warmed up. The primary window will display the real-time current and flow readings. Push the down arrow ▼ to view particle concentration.
b. To view or configure the instrument settings, follow the steps in “To View or Configure User Settings”. If the zero offset needs to be reset, connect a High Efficiency Particulate Air (HEPA) Filter to the Sample Inlet connector. Allow charged particles already within the system to purge (observed as a steady current reading) before resetting zero offset.

c. To view the instrument status, follow the steps in “To View Instrument Status”.

**To View or Configure User Settings**

1. Press the down ▼ arrow until you reach the User Setting Menu.

2. Press **Enter** to enter the Flow Control menu. Use the left ▶ or right ▲ arrow to toggle the flow control between on, off and manual. This setting enables flow control (activates the internal flow valve) to the value set in the flow setting menu, disables flow control which holds the flow valve fully closed, or switches to manual flow control where the internal valve is fully open and control is achieved with a user-supplied external needle valve or critical orifice.

3. Press the down ▼ arrow to enter the flow setting menu. Use the left ▶ or right ▲ arrow to activate the digit you want to edit (flashing number). Then use up ▲ or down ▼ arrow to set to the desired flow rate value. Hit **Enter** to save the setting or hit **ESC** to abort the setting.

4. Press the down ▼ arrow to enter the Average Charge/Particle setting menu. Use the same method as flow setting to enter the average number of charges carried by each particle.

5. Press the down ▼ arrow to enter the Analog Output scale setting menu. There are 11 scale options:
   - -12.5 to +12.5 pA
   - -1.0 to +1.0 pA
   - 0 to -12.5 pA
   - 0 to -10.0 pA
   - 0 to -1.0 pA
   - 0 to -0.1 pA
   - 0 to +0.1 pA
   - 0 to +1.0 pA
   - 0 to +10.0 pA
   - 0 to +12.5 pA
   - OFF

*Note: The analog port is provided for backward compatibility with older electrometers. The resolution is limited to 16-bit.*
It is much more accurate to use the digital (USB or Serial) ports.

Use the left or right arrow to scroll through the scale options. The scale change is effective immediately.

6. Press the down arrow to enter the Data Average Time setting menu. Use the left or right arrow to select one of the running average time options: 1, 2, 3, 4, 5, 6, 10, 12, 15, 20, 30, 60 seconds.

7. Press the down arrow to enter the Zero Offset Reset menu. Zero offset is the background current which should be subtracted from each measurement reading. With the temperature stabilization circuitry and the large dynamic range features of this electrometer, zero offset should not require adjustment very often. It is recommended that the zero offset is reset when the offset is high and after changing the electrometer filter. To reset the zero offset of the electrometer, connect a High Efficiency Particulate Air (HEPA) Filter to the Sample Inlet connector. Allow charged particles already within the system to purge (observed as a steady current reading) before setting zero. Then press the left or right arrow button. It takes one minute to collect new zero offset and overwrite the previous value. The zero offset reset is cancelled if ESC is pressed during the reset process and the display returns to the User Setting Menu.

8. Press ESC at any of the previous steps to return to the User Setting Menu.

9. Press ESC again to return to the display aerosol current and flow rate.

To View Instrument Status

You may view instrument status using the buttons on the front panel of the instrument or by opening the instrument status dialog from the Aerosol Instrument Manager software, described in the next chapter.

To view instrument status using the buttons on the front panel:

1. Press the up or down arrow button until you reach the Status Viewing menu.

2. Press Enter to view the aerosol temperature.

3. Press the down arrow to view the aerosol pressure.

4. Press the down arrow to view the ambient pressure.

5. Press the down arrow to view the cabinet temperature.

6. Press the down arrow to view the valve duty cycle.
7. Press the down ▼ arrow to view the USB status.
8. Press the down ▼ arrow to view the current zero offset.
9. Press the down ▼ arrow to view the firmware version.
10. Press the up ▲ or down ▼ arrow to scroll through the status data if necessary.
11. Press ESC at any of the previous steps to return to the Status menu.
12. Press ESC again to return the primary current and flow display window.

Computer Control

The 3068B Aerosol Electrometer can be controlled by a computer, either with the Aerosol Instrument Manager® software developed by TSI or by other software.

Using Aerosol Instrument Manager® Software

The software designed to be used with the Model 3068B Aerosol Electrometer is called Aerosol Instrument Manager® software. Aerosol Instrument Manager software supports many other TSI instruments to provide a uniform user interface. The Aerosol Instrument Manager software that supports the Electrometer is shipped as an accessory to the instrument. Connect the instrument to a computer using either the enclosed USB or serial cable. Follow the instructions in Chapter 5, “Aerosol Instrument Manager Software” of this manual to install and run the software.

Using Other Software

Software that allows a computer to communicate using the serial port may also be used to control and collect data from the Electrometer. For example, you may wish to develop specialized software using Microsoft® Visual Basic® or National Instruments™ LabVIEW® software. This can usually be accommodated using the serial-port (RS-232) commands (see Appendix D, “Serial Commands”). Please note that TSI does not support third party software. The command set is provided for your convenience only.

©Visual Basic is a registered Trademark of Microsoft Corporation.
©LabVIEW is a registered trademark of National Instruments.
CHAPTER 5
Aerosol Instrument Manager® Software

This chapter describes:
- Installation requirements
- Getting started
- Software procedure

This section describes the installation requirements for the Aerosol Instrument Manager® software and the installation procedure.

Installation Requirements

To use this software we recommend a personal computer with the following minimum features, components, and software:

- A Pentium® 586 processor or higher.
- A SVGA color monitor.
- Microsoft Windows® 2000 or Windows® XP operating system.
- A hard drive large enough to accommodate Windows, the Aerosol Instrument Manager software and data files.

**Note:** The amount of disk space required depends on the number of samples you collect, the amount of information collected, and the sampling period. After you have collected a number of samples, you may want to look at the file size to estimate how much storage space you will be using.

- A CD-ROM drive.
- 256 MB or more of random access memory (RAM).
- A mouse and a keyboard.

®Pentium is a registered trademark of Intel Corporation.
®Microsoft® Windows® 2000 and Windows® XP are registered trademarks of Microsoft Corporation.
Installation

Install the Aerosol Instrument Manager® software as follows:

1. Shut down (exit) all programs/applications on the Windows desktop.

2. With the computer on and Windows running, insert the Aerosol Instrument Manager CD-ROM in your CD drive to run the autorun.exe from the CD.
   a. If AutoPlay is enabled on your PC, the setup program will begin automatically and the introduction screen will be displayed on the Windows desktop.
   b. If AutoPlay is not enabled, select Run from the Start menu and type: D:\autorun (where D is the letter corresponding to your CD drive) in the Open box and press OK.

3. Follow the instructions as the setup program runs. When setup is complete, you should read the readme.htm file. The readme.htm file contains information that could not be included in this manual. If you decide not to read the file immediately, you can access the file later using a browser such as Internet Explorer.

4. When the installation program finishes, remove the CD-ROM.

The setup program creates a directory (folder) called "Aerosol Instrument Manager" on your hard disk (assuming you accepted the default directory name). The directory contains the required program files and sample data files.

The setup program also creates a new item in the Start Menu called “TSI” and an icon for the Aerosol Instrument Manager.

Note: Before creating a TSI menu item, the setup program checks for an existing one. If one is present, it adds the icon only.
**Getting Started**

This section is designed to give you an introduction to the basic operation of the Aerosol Instrument Manager® software. Using it you will:

- Start the program.
- Open an existing file (from the example files provided with the program).
- Change how data is viewed.
- View another sample in the same file.
- Playback (review) the graphs for several data samples in a “slide show” fashion.
- Select a data hot spot.
- Zoom in and zoom out on data in a graph.
- Print information displayed on the desktop.
- Export data to a file.
- Arrange the windows that are open on the desktop.
- Quit the program.

**Start the Program**

To start the program, proceed as follows:

From the Windows desktop, press the Aerosol Instrument Manager icon or press the Start menu and then select **All Programs|TSI|Aerosol Instrument Manager**.

The Aerosol Instrument Manager desktop appears as shown in Figure 5-1.
Open an Existing File

1. Select **File | Open…** on the toolbar. The “Open Instrument Associated Data Files” window opens.

2. When the “Open Instrument Associated Data Files” window appears, select a file with the extension ".E68” for the Aerosol Electrometer.

3. If necessary, browse for the drive/directory where data files are stored. (Example files are included with the program and were installed in the Aerosol Instrument Manager folder when the program was installed.)
Select the data file that you want to open and click **Open**. At least two windows open on the desktop: a window containing a graph of the sample data, and the Samples List window.

**Note:** If the file has been opened before, it may display more than one graph and/or table. The program remembers the windows that were open on the desktop when you last closed the file and reopens them when you access the file again. If the file contains a sequence of samples all the files in the sequence will be accessed. See Appendix G, “Sequence Files” for information about sequence files.

The Samples List window opens whenever you open a data file and remains open on the desktop as long as the data file is open. Closing the Samples List window closes the data file (and all its open windows).

### Change How Data is Viewed

You can view aerosol electrometer data in tables or graphs. The following procedure provides an example of how you can change how data is viewed.

1. Open one of the sample files for an aerosol electrometer.

2. With the graph window active on the desktop, press the right mouse button to open the popup menu. You may choose to display the data in the graph as either electrometer current or calculated concentration.

![Figure 5-2](Graph View Popup Menu)
Note: Some of the items on this menu are discussed later in the next chapter under the section titled “Context-Sensitive Menus”.

3. Experiment with other views by selecting options from their popup menu to see how your selections change the data. You may also select items from the Format Menu. Refer to “Format Menu” in this chapter for a list of formatting options with detailed explanations.

View Another Sample in the Same File

1. To view another sample in an open file, select the icon (go forward one sample) from the toolbar or simply use the mouse button to highlight a sample in the samples view. The data for that sample will display in each of the open windows.

2. You can continue to step through the samples by pressing the icon until you reach the last sample. The sample currently displayed in the open window is highlighted in the Samples List window.

You can use the following icons to display other samples:

- [ ] First Sample. Advance to the first sample.
- [ ] Previous Sample. Advance to the previous sample.
- [ ] Next Sample. Advance to the next sample.
- [ ] Last Sample. Advance to the last sample.

Playback (Review) Data Samples

You can display sample graphs and tables in a slide show fashion (to preview sample results or compare sample differences) as follows:

1. From the Samples List window, select the samples you want to play back using one of the following actions:

   Select Sample | Select All, to play back all samples.

   or

   Select individual samples using the mouse and the Ctrl key to highlight those samples you want to see. (You must select at least two samples.)

   or
Select a group of samples by holding down the left mouse button and moving the mouse to “rubber band” (outline) the samples you want to select.

**Note:** The Playback menu items and toolbar icons are only enabled when the Samples view is the active view.

2. When you have selected the samples you want to view, select **Playback** | **Play**. The setup box shown in Figure 5-3 appears.

![Playback Setup Dialog Box](image)

**Figure 5-3**
Playback Setup Dialog Box

3. Select the sample viewing time and whether you want the samples displayed once or continuously. Playback begins immediately. For better viewing, it may be necessary to minimize the Samples List window.

4. You can pause the playback at any time by selecting **Playback** | **Pause**. Select **Playback** | **Play** to continue playback where you left off. You can stop playback at any time by selecting **Playback** | **Stop**. When you stop playback, you cannot restart it. Use **Playback** | **Pause** and **Playback** | **Play** if you want to stop and start playback.

You can also control playback by using icons on the toolbar. The icons perform the following operations:

- ![Stop](image)
  Stop. Stop playback.

- ![Pause](image)
  Pause. Pause playback on current sample.

- ![Start](image)
  Start. Start playback or restart playback.
Select a Data Hot Spot

When a graph is open on the desktop, you can find the values of a data point as follows:

1. Position the pointer on the line, or data point so that the pointer becomes a pointing hand. This indicates that your mouse is over a data point on the graph.

2. Press the left mouse button to display the values. Figure 5-4 shows how the data values would be displayed for an aerosol electrometer sensor.

Figure 5-4
Use the Mouse to Directly View Data Values (AE sample file)

Tip: After you have a data hot spot selected, use the arrow keys or the ">" and "<" keys to move the cursor right or left (from one value to the next), or grab the vertical bar and drag it to another location. Refer to Appendix F for a list of other keys or key combinations you can use to navigate and perform operations without using the mouse.
Delete/Undelete Samples

To delete samples from a file, you must first mark them for deletion and then Save the file. The following procedures will permanently delete samples from a file:

Mark samples for deletion as follows:

1. Select the sample you want to delete from the Samples List window (you can select multiple samples).

2. Select Sample | Delete/Undelete Sample or on the toolbar. The samples will be shown as “Deleted.” However, they will not be permanently removed from the file until you Save the file.

Save the file and permanently delete all samples marked for deletion:

1. With at least one sample marked for deletion in the active file, select File | Save. You will get a message stating: “Some samples have been marked for deletion. Do you want them permanently removed?” Click Yes to remove them or No to keep them.

2. Select Yes. The files marked for deletion are permanently deleted.

Note: A message will appear to remind you to save the file when you close the file or exit the program. If you click Yes, the same message stating “Some samples have been marked for deletion. Do you want them permanently removed?” will appear. Respond Yes to delete the marked samples and No to close the file without deleting them.

Zoom In and Out on Data in a Graph

You can zoom in on data displayed in a graph as follows:

1. Use the mouse to position the cursor (pointer) at one corner of the area you want enlarged.

2. Press down on the left mouse button and drag the mouse to the opposite corner of the data you want enlarged.

3. Release the left mouse button. The area you selected is enlarged.

4. You can continue to zoom further by repeating steps 1 through 3.

To Unzoom, select Format | Undo Zoom or on the toolbar. The enlarged area is returned to normal view.
Print Information Displayed on the Desktop

You can print the information displayed in the active window on the desktop as follows (you must have a printer properly installed):

1. With a graph or table window active on the desktop, select File | Print Preview or from the toolbar.

2. Review that what you see in the print preview window is what you want to print (an example is shown in Figure 5-5), and then select Print from the Preview box. The contents of the window are sent to your printer.

You can immediately print a window without previewing it by selecting File | Print or from the toolbar.

![Figure 5-5](image-url)
Export Data to a File

You can export data from an Aerosol Instrument Manager file (either a single sample of the file or multiple samples of the file) for use in another program either manually or automatically.

To Export Data to a File Manually

To manually export data to be used in another program:

1. Select the sample or samples to be exported as follows:

   To export data from a single sample, display the sample data in an active window on the desktop.

   To export data from multiple samples, select (highlight) the samples you want to export from the Samples List window.

2. Select File | Export. An Export Parameters box appears as shown in Figure 5-6.

3. Select the data you wish to export. You may select Electrometer Current, Calculated Concentration, and/or Sample Flow.

4. Select the extension for the file you want to export data to. You can select from three delimiters: comma, tab, or semicolon. It is recommended to use Tab as the delimiter if you choose .xls as the file extension.
5. After selecting the export parameters, if you would like to specify an alternate output file name, press the Save As... button.

6. If you press the Save As... button, a file save dialog will open. From here, select the drive/directory you want to export the data to in the file dialog box and enter a filename. The system automatically adds the file extension to the file that you have selected. Press Save. This file name will appear under the Output File Name in the export options dialog.

7. Press OK.

To Export Data to a File Automatically

To export data automatically to a file for use in another program (such as Microsoft® Excel®):

1. Establish a connection to the Aerosol Electrometer sensor by choosing File|New or File|Open.

2. Select Run|Connect to Instrument (if not already connected).

3. Select Run|Auto Export before you begin to collect data.

4. Select Run|Start Data Collection. The data is exported to the file as it is collected.

Arrange Open Windows

When you have several windows open on the desktop it is helpful to arrange them for easier viewing.

To arrange windows, select an item from the Window menu. You can arrange windows on your desktop horizontally, vertically, have them cascade, or arrange them in a predetermined auto-fit two- or four-pane layout. Refer to your Windows documentation for examples and more information for Tile horizontal, Tile vertical, and cascade layouts. You can also use the toolbar for the two-pane or four-pane layout as shown in Figure 5-7 (two-pane layout shown) for an aerosol electrometer file.

©Microsoft and Excel are registered trademarks of Microsoft Corporation.
All of the program windows that are currently open on the desktop are listed at the bottom of the Window menu under the Close All item. To make a window active and bring it to the top of all windows, select the name of the window from the list of open windows.

**Quit the Program**

To end the program, select File | Exit. All windows and files open on the desktop are closed. If you have made changes to a file and have not yet saved it, you will be prompted to do so.
Software Procedures

Before using the information in this section, read “Getting Started” earlier in this chapter. This section provides getting started information to help you understand the basics of how the program works.

The subsections of this section provide:

- “How To...” information for: setting properties for an Aerosol Electrometer and how to collect sample data for analysis by the program.
- A description of all menus and menu items available when using an Aerosol Electrometer (or viewing data files).

How to Set Up Instrument Properties

The Properties dialog box can be opened through one of the menu options File | Properties or Run | Properties or using the shortcut <Ctrl+R>. For a new sample, connect the instrument to the computer (refer to "Connecting to the Computer" in Chapter 2 of this manual, if necessary) and then open a new Aerosol Electrometer file (*.E68). Before starting a new sample, select File | Properties or Run | Properties.

The Properties dialog box contains three tabs: Scheduling, Settings, and Communications.

Scheduling Tab

The Scheduling tab lets you select the number of samples, the length of each sample, how often samples are collected, and the start time for the sample. You cannot change the averaging interval for a file that already has data. If you want to change the averaging interval, you must start a new file. Figure 5-8 shows an example Properties dialog box showing the Scheduling tab. A description of each parameter follows.
Figure 5-8
Scheduling Tab of the Properties Dialog Box

Table 5-1
Descriptions of Scheduling Parameters for an Aerosol Electrometer

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample length (Sec)</td>
<td>This is the amount of time (in seconds) that data will be collected from the TSI sensor for each sample. The initial default value is 120 seconds (2 minutes). The maximum value allowed is 86400 (24 hours).</td>
</tr>
<tr>
<td>Number of Samples</td>
<td>This is the total number of samples you want to collect. The maximum value allowed is 65535.</td>
</tr>
<tr>
<td>Total Sample Time</td>
<td>This field is calculated by the software and shows the total sample time based on the values you entered in the Sample Length and Number of Samples boxes. The value is displayed in hours, minutes, and seconds. Note that when multiple samples are collected, the total sample time is longer than the Sample Length × Number of Samples. Extra overhead time is needed to open sample data files, transfer and save data, and close data files.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Averaging Interval</td>
<td>This is the number of seconds of data collected that will be averaged together to make up one data point. The number of data points in a sample is equal to the (Sample Length/Averaging Interval). The maximum number of data points allowed for a sample is 28,800. For an Aerosol Electrometer, the minimum and default averaging interval is 1 second.</td>
</tr>
<tr>
<td>Scheduled</td>
<td>Select <strong>Only Once</strong> to collect one set of samples. For continuous monitoring, select <strong>Repeat Every</strong> and then select the hours and minutes between samples. Note that extra overhead time is needed for file handling so the time selected for continuous monitoring should be longer than the total sample time which includes some overhead time.</td>
</tr>
<tr>
<td>Start At Time</td>
<td>If you don’t check this box, sampling begins as soon as you select <strong>Start Data Collection from the Run menu or by pressing the start button on the toolbar</strong>. If you want to select a start time, check the box and enter the clock time at which you want sampling to begin. The program uses a 12-hour or 24-hour clock, depending on how your PC is set up. If your PC is set up to use a 12-hour clock, you must indicate if the time is AM or PM by leaving the PM box blank or checking the PM box. The reference time for the program is the time at which your computer is set.</td>
</tr>
</tbody>
</table>

**Files of Sample Sessions That Run Past Midnight**

The files for sample sessions that run past midnight are handled differently than those that start and stop on the same date. In this case a sequence of files is created, with each file in the sequence given a unique filename extension identifying its proper order. Appendix G provides a complete description of sequence files including how to access a file that is part of a sequence.

The software provides an auto-save feature for sample times greater than 300 seconds (5 minutes). Intended to prevent data loss in the event of a computer failure, power loss, etc., this feature automatically writes the sample data to the data file after each 5-minute interval. The maximum data loss is less than 5 minutes.

**Settings Tab**

The Settings tab, Figure 5-9, allows you to specify a sample flow set point and average particle charge. You may also view the current offset read from the instrument, the instrument ID, add a title for the sample, and include any comments about the sample. The
information is displayed when you view the Settings window or when you print out sample results. The table below describes each of the fields in this dialog tab.

![Figure 5-9](image)

The Settings Tab of the Properties Dialog Box

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample Flow (lpm)/Manual Flow Setting (lpm)</td>
<td>When setting up for a new sample, the current sample flow control mode is read from the instrument. (The flow mode may be changed using the front panel of the instrument or using the instrument status dialog window.) For each sample, you may enter a sample flow rate. When the flow control is set to “ON” or automatic mode, the flow value entered in this dialog is sent to the instrument as the flow set point and the actual flow rate is read from the flowmeter inside the instrument and used to calculate particle concentration at each measurement interval. In <strong>manual</strong> mode, the flow rate you enter in this dialog is subsequently used to calculate particle concentration. The value must be between 0.3–10.0 L/min.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Average Particle Charge (C)</td>
<td>You may enter a value for the average charge per particle according to your sample stream. This value must be between 0.01–60.0 coulombs.</td>
</tr>
<tr>
<td>Offset (fA)</td>
<td>This is the zero offset value read from the instrument and stored with each sample. The electrometer current values sent by the instrument already have this offset value subtracted from them. It is listed for diagnostics only. If the number is very large (over ±100 fA), the instrument may not have been zeroed properly.</td>
</tr>
</tbody>
</table>

**Communications Tab**

The Communications tab lets you set up and test the communications port. It is only available when you are connected to an instrument. You can tell you are connected when the New Sample icon is the last icon in the Sample View or you see the text “Connected” in the status bar. Figure 5-10 shows the Communications tab for the Aerosol Electrometer. Table 5-3 describes the fields and buttons of the Communications tab for the Aerosol Electrometer model.

![Figure 5-10](image)

*Figure 5-10*

The Communications Tab of the Properties Dialog Box for an Aerosol Electrometer
Table 5-3
Descriptions for the Communications Tab

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port</td>
<td>Lists the ports available on your computer system and lets you select the port that is connected to the TSI sensor. This may be a serial or USB port.</td>
</tr>
<tr>
<td>Instrument</td>
<td>Displays the instrument model (3068B).</td>
</tr>
<tr>
<td>Serial No.</td>
<td>Displays the instrument serial number.</td>
</tr>
<tr>
<td>Version</td>
<td>Displays the instrument firmware version.</td>
</tr>
<tr>
<td>Status</td>
<td>Displays “Connected” if we have a connection active on this port.</td>
</tr>
</tbody>
</table>

How To Collect Sample Data

The Aerosol Electrometer allows you to collect data directly from the sensor as it is sampled.

Collecting Sample Data

To collect data from an Aerosol Electrometer, proceed as follows:

1. Make certain the instrument is connected properly to the computer. Refer to the instrument manual if necessary.

2. Select File|New or \[ on the toolbar. The New Instrument and Associated Data File dialog box opens on your desktop.

3. Select a filename (and, optionally, a location other than the Aerosol Instrument Manager folder). The default name is “AIM1” for the first file you open, “AIM2” for the second file you open and so on. You can accept the default name or enter any name you choose.

4. Verify that the “Files of Type” box indicates the correct extension for the sensor you are using (the extension indicates the correct instrument model number, for example, .E68 for a Model 3068B Aerosol Electrometer). You do not need to enter an extension in the filename box. It will be automatically assigned the extension that you selected.

5. After you enter a filename (or if you accept the default name) press the Open button.

If you get the following error message when opening a New file, press the OK button to open the Properties dialog box.
Use the Communications Tab to verify the connection to the sensor and make certain the sensor is turned on.

Once the program connects with the instrument, the Samples List window, Data Graph, Data Table and Statistics windows open on the desktop in an auto-fit 4-pane layout.

6. Select **Run|Start Data Collection** or 
   on the toolbar. Sampling will proceed as set up in the Properties dialog box.
   When the program begins collecting sample data, the data is displayed in the windows that are open on the desktop.
   As each sample finishes, the data for the sample is stored and a new sample begins. When the last sample finishes, sampling stops, but the windows remain open.

7. View, print and export the sample data using procedures described in the “Getting Started” section earlier in this chapter.

**Software Menus**

This section describes the software functions available for the Aerosol Electrometer software. There are two types of menus you can use: desktop menus and context-sensitive or popup menus.

- Desktop menus are those menus listed at the top of the Nanoparticle Surface Area Monitor desktop. They include: **File, Run, Format, View, Window, and Help**.

- Popup menus are those menus that appear when you click the right mouse button when the cursor is positioned in an active window.

Nearly all menu items are available from both a desktop menu and a popup menu, though a few items are only available in one or the other. This section presents the items of the desktop menus first and then describes the menu items that are available only through the popup menus.

In addition to these menus, a toolbar, located just beneath the desktop menus, provides shortcuts to the most commonly used menu functions.
Shortcut keys (keyboard keystrokes that do not require the use of the mouse) are also available. They are described at the end of this section.

**Desktop Menus**

Desktop menus are listed at the top of the Aerosol Instrument Manager desktop. This section describes each of the desktop menus and the menu item available through the menu.

**File Menu**

The items of the File menu are used to open, save, and recall files and perform other program operations. In Figure 5-12, the figure shows the File Menu options for the Aerosol Electrometer.

![Figure 5-12](Image)

**Figure 5-12**

File Menu Options for an Aerosol Electrometer

**New**

Select **File | New** or **on the toolbar to open a new file and prepare to collect sample data.**

After you select **New**, you are prompted to enter a filename. Accept the default filename or enter any filename you chose, then select **OK**.

A Samples List window and a graph window open on the desktop with the filename you entered and you are ready to start collecting data. Refer to “**How to Collect Sample Data**” earlier in this chapter for a complete description.
**Open**

Select **File | Open** or [ ] on the toolbar to open an existing file. By default, sample files are stored in the same directory as the Aerosol Instrument Manager program. All files will automatically be given the appropriate filename extension according to the sensor model you are using (see above description). If you store data files in another directory or on another drive, you must first display the file pathname in the Open window before you can select and open it.

**Note:** When opening files for sample sessions that run past midnight, refer to the description of Sequence Files in Appendix G and for information on how the files are opened.

When the file opens, a window opens on the Aerosol Instrument Manager desktop containing data from the first sample in the file.

You can have many samples and many files open on the desktop at the same time. Only one window, however, is the active window.

**Close**

Select **File | Close** or [ ] to close a file (and all the windows associated with it). If there are windows open on the desktop from more than one file, Close will close only those windows associated with the file whose window is currently active.

If you attempt to close a file that has been changed but not saved, you will be prompted to save the changes before closing the file.

If you have marked a sample or samples for deletion, but have not saved the file, you will get the following message: “Some samples have been marked for deletion. Do you want them permanently removed?” If you click **Yes** the samples marked for deletion are permanently deleted. If you click **No** the samples marked for deletion are not deleted. They are saved, and are no longer marked for deletion.

**Save**

Select **File | Save** or [ ] on the toolbar to save sample data to a file.

If you have marked a sample or samples for deletion, but have not saved the file, you will get the following message: “Some samples have been marked for deletion. Do you want them permanently removed?” If you click **Yes** the samples marked for deletion are permanently deleted. If you click **No** the samples marked for deletion are not deleted. They are saved, and are no longer marked for deletion.
**Save As**

Select **File | Save As** to save data in an existing file to a new filename. (The file contents are duplicated to the new filename. If you want to delete the original filename, use Windows Explorer to do so.)

After you select **Save As**, you can select a drive/directory. You can use the same filename if you save the file to another drive/directory, but if you want to save the file to the same directory, you must give it a new name.

Do not add the filename extension. It is added automatically when you select **Save**.

**Import**

This menu option is used to import data collected by CPC 377X Series, WCPC 3781, and older version SMPS and APS data files. It is not normally used with the Electrometer but is included as part of the software module. This option is described in the *Aerosol Instrument Manager Software* user manuals for those instruments.

**Export**

Select **File | Export** to export data (either a single sample or multiple samples of a file) for use in another program. Data is exported in a delimited excel, csv, or text file. Refer to “Export Data to a File” earlier in this chapter for information.

**Properties...**

Select **File | Properties** to open the properties dialog to view and to set parameters for the currently selected sample. All properties are stored in the file with each sample collected by the Aerosol Electrometer. The parameters that can be set for each sensor on each tab are described in “How to Collect Sample Data” earlier in this chapter.

**Print**

Select **File | Print** or to print the active window on the desktop in a report format. If you want to preview the output before printing it, select **File | Print Preview** or .

Refer to your Windows documentation for information about the Print dialog box.

**Print Preview**

To avoid printing something you don’t want, select **File | Print Preview** or to see what your printed output will look like before selecting **Print**.
Print Setup
Select File | Print Setup to set up the printer for printing. Refer to your Windows documentation and your printer’s documentation for information about setting the printer parameters.

List of Recently Accessed Files
Between the Printer Setup and Exit menu items is a list of the most recently accessed data files (a maximum of four files is displayed). These are accessed from the menu by selecting File | 1, 2, 3, or 4.

The list provides a shortcut to these files so you can bypass the Open command. To open one of the files listed, use the mouse to highlight it and then click the left mouse button. The file opens on the desktop.

Exit
Select File | Exit to end the program.

Run Menu
The items available under the Run menu are used to start and stop data collection.

![Figure 5-13](Run Menu for an Aerosol Electrometer)

Start Data Collection
With a new file open on the desktop, select Run | Start Data Collection or on the toolbar to begin collecting sample data. Samples are collected according to the sample length, number of samples, scheduled times, averaging interval, and other parameters set in the tabs of the Properties dialog (see earlier in this chapter).

Note: If a start time is set, this menu item (and its associated icon) is disabled.
Once you select **Start Data Collection**, sampling begins immediately. As data is collected, it is displayed in the open windows.

**Finish Current Sample**
Select **Run|Finish Current Sample** when you want to stop collecting sample data prematurely. (Before completing all samples as set in the Properties dialog.) When you select this item, the current sample is allowed to finish before sampling ends.

**Stop Current Sample**
Select **Run|Stop Current Sample** or \[\] on the toolbar when you want to stop collecting sample data immediately. When you select this item, sampling stops and data collected to this point is stored in the data file.

**Abort Current Sample**
Select **Run|Abort Current Sample** when you want to abort data collection. Aerosol Instrument Manager automatically saves the data to the file every 5 minutes; therefore, once data has been written to the file, this menu item is unavailable. You must then stop the current sample and then delete the sample (see description under Sample Menu) in order to discard the data. Otherwise, selecting this item prior to five (5) minutes of sample time, stops sampling and the data for the current sample is discarded.

**Connect to Instrument**
Select **Run|Connect to Instrument** to connect the software to the Aerosol Electrometer. You must connect before you can begin sampling. When you select **File|New**, the software automatically connects to the Aerosol Electrometer.

**Disconnect from Instrument**
Select **Run|Disconnect from Instrument** to disconnect the software from the Aerosol Electrometer.

**Auto Export ...**
Select **Run|Auto Export...** to automatically export data for use in another program. Refer to “Export Data to a File” earlier in this chapter for additional information.

**Properties...**
This menu item provides a shortcut to the same Properties menu item listed under the File menu and appears here for convenience.

Select **Run|Properties** to display the Properties dialog that lets you set and view the parameters used by the Aerosol Instrument Manager software for each sample.
The parameters that can be set are described earlier in this chapter.

**Playback Menu**

The Playback menu appears only when a Samples List window is active on the desktop. Its purpose is to allow you to display graphic and table windows in series, like a slide show, so that you can compare samples or view a series of samples.

Refer to “Playback (Review) Data Samples” earlier in this chapter for instructions.

### Play

Select **Playback | Play** or  from the toolbar for playing back the samples you selected. First select the time you want each sample displayed (full speed, 0.5, 1.0, 2.5, or 5.0 seconds). Then select whether to view the samples once or continuously. As soon as you select **Play Once** or **Play Continuous** each sample selected for playback is displayed in the open views for the specified time period, until all the samples have been displayed. If you selected **Play Continuous** from the Playback Setup dialog box, the series repeats itself indefinitely.

### Pause

Select **Playback | Pause** or  from the toolbar to interrupt the playback of the samples. This feature lets you stop playback to view the data of an interesting sample without canceling the playback of all selected samples. When you want to start playback again, select **Playback | Play**.

### Stop

Select **Playback | Stop** or  from the toolbar to end sample playback before all samples have been displayed. If you select Stop and you want to restart sampling, you must select **Playback | Play**, select the display time for each sample, and begin displaying samples from the first selected sample.
Format Menu

The Format menu has several variations depending on the active window. The menu items of the Format menu let you control how information is presented in tables and graphs including: graph type, grid lines, font, color, etc., when a graph or table window is active. When a Samples List window is active on the desktop, the menu items of the Format menu let you determine how items in the Samples List window are displayed. You can select large or small icons, or list the samples with or without details. Details include: date, pathname, and title of the sample.

When a window is active on the desktop, you can display the Format menu items (plus other menu items) by placing the cursor in the window and clicking the right mouse button.

![Format Menu](image)

Figure 5-15
Format Menu (A) When A Graph Window Is Active; (B) When A Samples List Window Is Active

Y Axis

This menu item is available only when a graph window is active on the desktop.

Select Format | Y Axis or select Y Axis... from the graph context menu to change the Y axis scale. See Figure 5-16. By default, the graphs display in linear with auto scaling. You can select either linear or log and you may select a minimum and/or maximum value for the Y axis.

If you select the Max radio button, the corresponding edit box will be enabled and you may enter a value for the Y maximum.

Note: The log scale option is not available when displaying electrometer current because this data may contain negative values.
View Boundaries
Select **Format | Display View Boundaries** to display the View Boundaries on the graph. Use the mouse to select and drag the boundaries to the desired location. View boundaries are active only if checked.

**Notes:** If the View Boundaries are active and a View Boundary is not visible on the left, move the mouse cursor to the far left edge of the chart and drag it to a displayable part of the chart.

*If the chart is zoomed, the view boundaries may not be shown on the chart without scrolling.*

Graph Type
Select **Format | Graph Type** to select the type of graph to display in the active window. The options are bar, line, area or points plus line. If the Graph toolbar is visible, you can select the option using the appropriate icon.

- Display graphs using bars.
- Display graphs using lines.
- Display graphs showing area.
Grid Lines
Select **Format | Grid Lines** to select the lines for the graph in the active window. The options are horizontal, vertical, both or none. If the Graph toolbar is visible, you can select the option using the appropriate icon.

- Display graphs with no grid.
- Display graphs with a horizontal grid.
- Display graphs with a vertical grid.
- Display graphs with both horizontal and vertical grids.

Color
Select **Format | Color** or from the toolbar to change the colors used to display items in the active window.

When you select **Format | Color**, the Graph Color or Table Color window opens depending on the active window on the desktop (Figure 5-17 shows both). These windows include a preview screen, a drop down list and a color palette. From the drop down list, select the name of the item you want to modify. The current color for that item is indicated in the color palette. Use the mouse to point to the new color for that item and click the left mouse button to select it. The preview screen then displays the item in the new color.
Figure 5-17
(A) The Graph Color Dialog Box; (B) The Table Color Dialog Box

Select items from the drop down list and colors as desired. When finished, press OK; the colors you selected will be used from that point on in all graphs and/or tables.

The items you can select for windows containing graphs are:

- Window Background
- Plot Area Background
- Labels
- Axis
- Data
- View Boundaries
- Data Hotspot Lines
The items you can select for windows containing tables are:
- Window Background
- Cell Text
- Grid Color
- Cell Background
- Fixed Area Text

Font
Select the **Format|Font** menu or from the toolbar to change the style and size of the text in all graphs or tables.

Select **Format|Font|Style...** to select a new font or change the font style, see Figure 5-18. You can select any font and font style available on your computer. The preview box lets you see what the text will look like before you implement it by selecting OK.

To change the font size, select **Format|Font|Small**, **Medium**, or **Large** (the default is Medium). To change the text size without using the menus, select the icon from the toolbar. Each time you select the icon the text size changes to the next text size. (Rotation is from small to medium to large.)

**Undo Zoom**
Select **Format|Undo Zoom** or from the toolbar to return a graph to its “normal” viewing size after you have zoomed in on a portion of the graph. See “Zoom In and Out on Data in a Graph” earlier in this chapter.
View Menu

The list of items in the View menu depends on which windows are open on the desktop and which one is active. The View menu lets you select the sample windows to open on the desktop and select parameters to view in those windows. A checkmark next to an item indicates the item has already been selected. Look under the Windows menu to find the item and make it the active window.

<table>
<thead>
<tr>
<th>View</th>
<th>Sample</th>
<th>Window</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td>Graph</td>
<td></td>
<td>F6</td>
<td></td>
</tr>
<tr>
<td>Table</td>
<td></td>
<td>Shift+F6</td>
<td></td>
</tr>
<tr>
<td>Statistics</td>
<td></td>
<td>F3</td>
<td></td>
</tr>
<tr>
<td>Settings</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Copy</td>
<td></td>
<td>Ctrl+C</td>
<td></td>
</tr>
<tr>
<td>Instrument Status…</td>
<td></td>
<td>Ctrl+I</td>
<td></td>
</tr>
<tr>
<td>Toolbars</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Figure 5-19
View Menu

Graph

Select View|Graph to open a graph window that displays the file's sample data based on electrometer current or calculated concentration.

Table

Select View|Table to open a table window that displays the file's sample data which includes electrometer current and calculated concentration.
<table>
<thead>
<tr>
<th>Date</th>
<th>Time</th>
<th>Electrometer Current (fA)</th>
<th>Calculated Concentration (#/cm³)</th>
</tr>
</thead>
<tbody>
<tr>
<td>04/26/06</td>
<td>16:02:01</td>
<td>0.850</td>
<td>63.7</td>
</tr>
<tr>
<td>04/26/06</td>
<td>16:02:02</td>
<td>0.210</td>
<td>15.6</td>
</tr>
<tr>
<td>04/26/06</td>
<td>16:02:03</td>
<td>0.690</td>
<td>51.8</td>
</tr>
<tr>
<td>04/26/06</td>
<td>16:02:04</td>
<td>-0.260</td>
<td>19.5</td>
</tr>
<tr>
<td>04/26/06</td>
<td>16:02:05</td>
<td>0.220</td>
<td>16.5</td>
</tr>
<tr>
<td>04/26/06</td>
<td>16:02:06</td>
<td>0.820</td>
<td>61.5</td>
</tr>
<tr>
<td>04/26/06</td>
<td>16:02:07</td>
<td>0.930</td>
<td>69.7</td>
</tr>
<tr>
<td>04/26/06</td>
<td>16:02:08</td>
<td>0.710</td>
<td>53.3</td>
</tr>
<tr>
<td>04/26/06</td>
<td>16:02:09</td>
<td>0.920</td>
<td>69.0</td>
</tr>
<tr>
<td>04/26/06</td>
<td>16:02:10</td>
<td>1.09</td>
<td>81.8</td>
</tr>
<tr>
<td>04/26/06</td>
<td>16:02:11</td>
<td>0.870</td>
<td>65.3</td>
</tr>
<tr>
<td>04/26/06</td>
<td>16:02:12</td>
<td>0.730</td>
<td>54.6</td>
</tr>
<tr>
<td>04/26/06</td>
<td>16:02:13</td>
<td>0.460</td>
<td>34.5</td>
</tr>
<tr>
<td>04/26/06</td>
<td>16:02:14</td>
<td>0.580</td>
<td>43.6</td>
</tr>
<tr>
<td>04/26/06</td>
<td>16:02:15</td>
<td>0.660</td>
<td>49.5</td>
</tr>
<tr>
<td>04/26/06</td>
<td>16:02:16</td>
<td>0.830</td>
<td>62.3</td>
</tr>
<tr>
<td>04/26/06</td>
<td>16:02:17</td>
<td>0.910</td>
<td>68.3</td>
</tr>
<tr>
<td>04/26/06</td>
<td>16:02:18</td>
<td>0.840</td>
<td>62.9</td>
</tr>
<tr>
<td>04/26/06</td>
<td>16:02:19</td>
<td>1.10</td>
<td>82.6</td>
</tr>
<tr>
<td>04/26/06</td>
<td>16:02:20</td>
<td>0.890</td>
<td>66.8</td>
</tr>
<tr>
<td>04/26/06</td>
<td>16:02:21</td>
<td>0.700</td>
<td>52.5</td>
</tr>
<tr>
<td>04/26/06</td>
<td>16:02:22</td>
<td>0.840</td>
<td>63.0</td>
</tr>
<tr>
<td>04/26/06</td>
<td>16:02:23</td>
<td>0.840</td>
<td>63.0</td>
</tr>
<tr>
<td>04/26/06</td>
<td>16:02:24</td>
<td>0.650</td>
<td>48.8</td>
</tr>
<tr>
<td>04/26/06</td>
<td>16:02:25</td>
<td>0.570</td>
<td>42.8</td>
</tr>
<tr>
<td>04/26/06</td>
<td>16:02:26</td>
<td>0.570</td>
<td>42.8</td>
</tr>
<tr>
<td>04/26/06</td>
<td>16:02:27</td>
<td>1.06</td>
<td>79.5</td>
</tr>
<tr>
<td>04/26/06</td>
<td>16:02:28</td>
<td>1.03</td>
<td>77.3</td>
</tr>
</tbody>
</table>

Figure 5-20
View Table
Statistics
Select View | Statistics to open a window of statistical information for the active sample.

![Statistics Table](image)

**Figure 5-21**
View Statistics

*Note:* The equation for calculated concentration and RMS is described in Chapter 7, under the section “Noisy Electrometer Output”.

Settings
Select View | Settings to view the settings for the current sample.

![Settings Table](image)

**Figure 5-22**
View Settings
Copy

Select **View|Copy** or ![Copy](image) from the toolbar to copy the active window to the clipboard so that you can “paste” it in other applications, for example a word processing program. You can only copy tables and graphs.

**Instrument Status ... (Ctrl+I)**

Select **View|Instrument Status (Ctrl+I)** to display a dialog window displaying status information for the Aerosol Electrometer. The information in this dialog is updated every second until the dialog is closed.

![Electrometer 3068B Instrument Status](image)

**Figure 5-23**

**Instrument Status Dialog**

From this dialog, you may also control the flows, set the flow set point, average particle charge, analog output mode, and zero the electrometer.
### Button Description

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flow Control</td>
<td>Press this button to toggle the flow control between on/off/manual mode.</td>
</tr>
<tr>
<td>Flow Set Point</td>
<td>Press this button to enable the window and enter a new set point value. This value must be between 0.3–10 L/min.</td>
</tr>
<tr>
<td>Avg. Particle Charge</td>
<td>Press this button to enable the window and enter a new average charge per particle. This value must be between 0.01–60 coulombs.</td>
</tr>
<tr>
<td>Analog Output Mode</td>
<td>You may select one of the analog output modes from this dropdown.</td>
</tr>
<tr>
<td>Zero the Electrometer</td>
<td>Press this button to begin zeroing of the electrometer. This process takes 60 seconds to complete. See Chapter 7, Troubleshooting, section “Unstable Zero Offset Level” for a detailed description of this procedure.</td>
</tr>
</tbody>
</table>

### Toolbars

Select **View|Toolbars** to display or hide the toolbars that appear on the desktop. Each toolbar is illustrated below:

- **Color and Font Toolbar**
  - ![Color and Font Toolbar](image)
- **Graph Toolbar**
  - ![Graph Toolbar](image)
- **Navigation Toolbar**
  - ![Navigation Toolbar](image)

By default, only the Main and Navigation toolbars are displayed.

To view what each icon (tool) does, position the cursor on the icon. A balloon will appear to describe the function of the icon.

Toolbars can be moved and resized if desired. To move a toolbar, position the cursor on a gap between two toolbars and press and hold the left mouse button. As you move the mouse, the toolbar moves with it. To resize a toolbar, position the cursor at an edge or corner of the toolbar window that you have moved and resize it as desired. You can hide a toolbar by selecting the “x” in the upper right corner.

### Sample Menu

The Sample menu lets you navigate through files with multiple samples.
Note: You can also navigate through files with multiple samples using the Navigation toolbar.

Beginning Sample
Select Sample | Beginning Sample or \( \leftarrow \) from the toolbar to display the data for the first sample of the file in the active window.

Previous Sample
Select Sample | Previous Sample or \( \leftarrow \) from the toolbar to display the data for the previous sample of the file in the active window.

Next Sample
Select Sample | Next Sample or \( \rightarrow \) from the toolbar to display the data for the next sample of the file in the active window.

Ending Sample
Select Sample | Ending Sample or \( \rightarrow \) from the toolbar to display the data for the last sample of the file in the active window.

Delete/Undelete Sample
Select Sample | Delete/Undelete Sample or \( \times \) from the toolbar to mark a sample for deletion or to unmark a sample that has been previously marked for deletion. Sample data that is marked as deleted are not physically deleted from the file until you select File | Save.

Select All
Select Sample | Select All to select (highlight) all samples in the Samples List window for playback or exporting. This item is only available when the Samples List window is the active window.

Window Menu
The Window menu items let you open, close and arrange the windows on your desktop. Refer to "Arrange Open Windows" earlier.
in this chapter and your Windows documentation for an example of what each command does.

<table>
<thead>
<tr>
<th>Window</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td>2-Pane Layout</td>
<td>Ctrl+K</td>
</tr>
<tr>
<td>4-Pane Layout</td>
<td>Ctrl+L</td>
</tr>
<tr>
<td>Cascade</td>
<td></td>
</tr>
<tr>
<td>Tile Horizontal</td>
<td></td>
</tr>
<tr>
<td>Tile Vertical</td>
<td></td>
</tr>
<tr>
<td>Close All</td>
<td></td>
</tr>
<tr>
<td>1 Data Graph [AIM1.E68]</td>
<td></td>
</tr>
<tr>
<td>2 Data Table [AIM1.E68]</td>
<td></td>
</tr>
<tr>
<td>3 Statistics Table [AIM1.E68]</td>
<td></td>
</tr>
<tr>
<td>4 Electrometer - Samples List [AIM1.E68]</td>
<td></td>
</tr>
</tbody>
</table>

**Figure 5-25**
Window Menu

All windows on the desktop, whether active or inactive, are listed after the Close All command; the active window is shown with a check mark. To make a different window active and bring it to the front, select it with the mouse.

**Help Menu**

The Help menu provides access to information about the program.

<table>
<thead>
<tr>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td>About Aerosol Instrument Manager...</td>
</tr>
<tr>
<td>Help Manual</td>
</tr>
</tbody>
</table>

**Figure 5-26**
Help Menu

**About Aerosol Instrument Manager**

Select **Help | About Aerosol Instrument Manager** to see the copyright statement for the program and view the version number of the software.

**Help Manual**

Select **Help | Help Manual** to see this manual. You must have Adobe Acrobat reader installed on your computer to view this file.

**Context-Sensitive Menus**

You can access context-sensitive menus, also called “popup menus,” by clicking the right mouse button when the cursor is in an active window. Each window has a popup menu as shown
below. The table following each popup menu describes where to find a description of that menu item.

**Samples View Popup Menu**

![Figure 5-27](image)

**Samples List View Popup Menu**

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>For a description, see ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Large Icons</td>
<td>Below</td>
</tr>
<tr>
<td>Small Icons</td>
<td>Below</td>
</tr>
<tr>
<td>List</td>
<td>Below</td>
</tr>
<tr>
<td>Detail</td>
<td>Below</td>
</tr>
<tr>
<td>Select All</td>
<td>Below</td>
</tr>
<tr>
<td>Properties…</td>
<td>Run Menu</td>
</tr>
<tr>
<td>Export</td>
<td>File Menu</td>
</tr>
</tbody>
</table>

**Select All**
Select this option to select (highlight) all samples in the Samples List window for exporting.

**Large Icons or Small Icons**
Use this option to display samples in the samples view as either large or small icons.

**List**
Use this option to display samples in the samples view in a list format.
Use this option to display samples in the samples view in a detailed list format. The date and time, file name and sample title are displayed.

Table View Popup Menu

- Color...
- Font
- Abort current sample
- Copy Ctrl+C
- Print...
- Print Preview...

Figure 5-28
Samples View in List Format

Figure 5-29
Samples View in Detailed List Format

Figure 5-30
Table View Popup Menu
Table 5-5
Table View Popup Menu

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>For a description, see ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color</td>
<td>Format Menu</td>
</tr>
<tr>
<td>Font</td>
<td>Format Menu</td>
</tr>
<tr>
<td>Abort current sample</td>
<td>Run menu</td>
</tr>
<tr>
<td>Copy</td>
<td>View Menu</td>
</tr>
<tr>
<td>Print</td>
<td>File Menu</td>
</tr>
<tr>
<td>Print Preview</td>
<td>File Menu</td>
</tr>
</tbody>
</table>

Graph View Popup Menu

- **Display As**
  - Y-Axis
  - View Boundaries
  - Abort current sample
  - Graph Type
    - Grid Lines
  - Color...
    - Font
  - Undo Zoom
    - Z
  - Copy
    - Ctrl+C
  - Print...
  - Print Preview...
  - Electrometer Current (fA)
  - Calculated Concentration (#/cm³)

Figure 5-31
Graph View Popup Menu

Table 5-6
Graph View Popup Menu

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>For a description, see ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display As</td>
<td>Below</td>
</tr>
<tr>
<td>Y-Axis</td>
<td>Format menu</td>
</tr>
<tr>
<td>Display View Boundaries</td>
<td>Format menu.</td>
</tr>
<tr>
<td>Abort current sample</td>
<td>Run menu</td>
</tr>
<tr>
<td>Grid Lines</td>
<td>Format menu</td>
</tr>
<tr>
<td>Color</td>
<td>Format Menu</td>
</tr>
<tr>
<td>Font</td>
<td>Format Menu</td>
</tr>
<tr>
<td>Undo Zoom</td>
<td>Format Menu</td>
</tr>
<tr>
<td>Print</td>
<td>File Menu</td>
</tr>
<tr>
<td>Print Preview</td>
<td>File Menu</td>
</tr>
</tbody>
</table>
**Display As**

Select **Display As** and then select either **Electrometer Current** or Calculated Concentration for display in the active window. Below is a graph view showing calculated concentration.

![Graph View Showing Calculated Concentration](image)

**Figure 5-32**
Graph View Showing Calculated Concentration

**Statistics View Popup Menu**

<table>
<thead>
<tr>
<th>Color...</th>
<th>Font...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Abort current sample</td>
<td>Copy Ctrl+C</td>
</tr>
<tr>
<td>Print...</td>
<td>Print Preview...</td>
</tr>
</tbody>
</table>

**Figure 5-33**
Statistics View Popup Menu
Table 5-7
Statistics View Popup Menu

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>For a description, see ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color</td>
<td>Format Menu</td>
</tr>
<tr>
<td>Font</td>
<td>Format Menu</td>
</tr>
<tr>
<td>Abort current sample</td>
<td>Run menu</td>
</tr>
<tr>
<td>Copy</td>
<td>View Menu</td>
</tr>
<tr>
<td>Print</td>
<td>File Menu</td>
</tr>
<tr>
<td>Print Preview</td>
<td>File Menu</td>
</tr>
</tbody>
</table>

**Status Bar Icons**

A status bar at the bottom of most windows provides information about what is being shown in the window as well as information about what operations are occurring.

Each icon is described below:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🚨</td>
<td>Attention. Errors were detected. You may float the mouse over the icon to display popup text describing the errors.</td>
</tr>
<tr>
<td>✅</td>
<td>The sample completed without errors.</td>
</tr>
</tbody>
</table>
CHAPTER 6

Maintenance

This chapter gives maintenance and service procedures for the Model 3068B Aerosol Electrometer.

Calibration and Performance

Each Aerosol Electrometer is calibrated at the factory by comparison with a factory standard Aerosol Electrometer while sampling the output of a Model 3080 Electrostatic Classifier. All new and repaired Aerosol Electrometers must agree with the factory standard within 2 percent.

Periodic Maintenance

Periodic cleaning of several portions of the Aerosol Electrometer is necessary to ensure proper performance. Accumulation of aerosol deposit on the insulator in the Electrometer aerosol filter assembly will cause current leakage to ground, resulting in incorrect current measurement. Clogging of the high-efficiency filter will result in high pressure drop through the system, causing error in the measurement of volumetric flow rates.

The service intervals depend on the aerosol concentration entering the unit.

Table 6-1
Maintenance Schedule

<table>
<thead>
<tr>
<th>Maintenance Task</th>
<th>Hours of Operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Replace the aerosol filter cartridge</td>
<td>Every 1000–4000 hrs of operation</td>
</tr>
<tr>
<td>Check the flowmeter</td>
<td>Every 1000–2000 hrs of operation</td>
</tr>
</tbody>
</table>
Replacing the Filter Cartridge and Cleaning the Electrometer

**WARNING**

High voltage is accessible in several locations within this instrument. Make sure you unplug the power source before removing the cover or performing maintenance procedures. Only a qualified technician should perform this maintenance.

A special filter with a wire mesh incorporated into the inner surface is used as the charge collector in the electrometer. The wire mesh allows the current from captured particles to bleed off the filter in a reasonable time. With use the filter will become clogged with particles from the sampled aerosol and have to be replaced. Follow the steps below to replace the electrometer filter.

![Electrometer Chamber Cover Screws](image)

**Figure 6-1**
Electrometer Chamber Cover Screws

1. Switch off the electrometer and disconnect the electric power cable.

2. Unplug tubes to the Sample Inlet and External Vacuum ports.

3. Remove the two (2) screws securing the filter access cover shown in Figure 6-1. Wear clean, lint-free gloves to reduce chances of contamination of interior parts. Pull the cover plate straight out. Be careful not to touch the plastic insulator attached to the inner side of the cover (Figure 6-2)—this will
reduce its insulating properties and increase the noise in the electrometer. Place it in a clean bag or on a clean surface.

4. Locate and remove the electrometer filter (Figure 6-2) by pulling it straight out.

5. Notice that a spring wire should connect the outer metal housing to the filter housing. This is to prevent electrostatic damage to the electrometer during filter replacement. If the wire is not connecting the two metal surfaces, adjust the wire position.

![Image](image.png)

**Figure 6-2**
Electrometer Filter, Insulator, and Spring Wire

6. Replace the filter with a wire-core filter provided in the accessory kit (TSI P/N 1602346).

7. Inspect the O-rings in the cover for nicks or cuts and replace if necessary. If the insulator is dirty or has been touched by bare fingers it should be cleaned and wiped with methanol or isopropanol and then acetone to remove all contamination.

8. Reinstall the electrometer cover.

9. Turn the instrument back on.

10. After replacing the filter, **it will often take several hours for the current reading to stabilize**. For best results, allow the
instrument to sit overnight and then reset the zero offset in the morning.

---

**Checking the Flowmeter**

To check the flowmeter, use a trusted “standard” volumetric flowmeter attached to the inlet of the instrument.

*Notes*: Vapor from wet cell flowmeters can cause error in the aerosol electrometer’s internal flowmeter. Therefore, if a wet cell (bubble) flowmeter is used, desiccant should be placed in line between the wet cell flowmeter and the inlet.

Automatic flow control is provided for flexibility. However, the instrument uses a volumetric flowmeter. Due to the pressure drop through the electrometer filter, the accuracy of the flow control is limited to 2% up to 2 L/min and 5% up to 10 L/min. More accurate flow control (and therefore a more accurate measurement) is possible by setting the flow control to manual mode and using an external needle valve or critical orifice to control the flow.

---

**Testing for Leaks**

Whenever an air leak is suspected or a significant part of the airflow system has been reassembled, perform a leak test to assure proper performance.

1. Disconnect the electric power cable.
2. Use the inlet shipping plug to block the Sample Inlet port.
3. Connect a vacuum pump with valve and gauge to the External Vacuum port. When the vacuum is at 18 inHg close the valve and monitor the gauge. If the vacuum changes by more than 0.1 inHg in 5 minutes, see “Isolating Leaks” below.
4. When the charger/electrometer chamber leak checks satisfactorily, reconnect inlet and outlet tubing to its original state.
5. Turn the instrument back on and make sure that the instrument performs as expected. If the instrument has been significantly disassembled, it may have to be recalibrated. Contact TSI customer service for assistance (see Chapter 8).
**Isolating Leaks**

1. Isolate the leak by wetting suspected joints with clean isopropyl alcohol while the system is under vacuum. The alcohol will be drawn into a leaky joint and evaporate, which results in a pressure increase in the vacuum gauge.

2. After isolating the leak, repair it (usually by greasing or replacing an O-ring, or by sealing a fitting).

3. Blow low-pressure clean, dry air through the repaired section to evaporate and remove any leftover alcohol.

4. If you cannot find the leak, or cannot repair the leak, please contact TSI for assistance.
CHAPTER 7
Troubleshooting

This chapter describes common difficulties that may arise when using the Model 3068B Aerosol Electrometer. Suggestions are given for abnormal and offset levels.

**WARNING**

High voltage is accessible in several locations within this instrument. Make sure you unplug the power source before removing the cover or performing maintenance procedures. Only a qualified technician should perform this maintenance.

---

**Error Handling**

The Electrometer has certain degree of self-diagnostics of operating errors. An error message will appear in the display in certain circumstance. All error messages start and end with “!” If an error occurs, refer to the following troubleshooting guide:

<table>
<thead>
<tr>
<th>Error message</th>
<th>Cause and Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>! FLOW METER!</td>
<td>Flowmeter communication is not working. Remove the electrometer cover and check whether the cable to the flowmeter is connected.</td>
</tr>
<tr>
<td>! ENGINE!</td>
<td>Electrometer engine A/D converter is not responding. Remove the electrometer cover and check whether the white flat cable connected to the electrometer engine block is connected (See Figure 3-3).</td>
</tr>
<tr>
<td>!FLOW= !0.13 LPM!</td>
<td>User requested flow cannot be achieved due to insufficient vacuum to draw the flow. Try to increase the vacuum. If the vacuum is very high and a low flow is set, it is possible that the vacuum has to be reduced.</td>
</tr>
</tbody>
</table>

The status light will blink in one of the following situations:

- The flow rate is not within ±10% of the specified value or if it is in manual control mode.

- The cabinet or aerosol temperature is greater than 50°C or less than 0°C.
The flat cable to the sensor is disconnected (see Figure 7-1 below).

![Flat Cable](image)

Figure 7-1
Location of the Flat Cable Connected to the Electrometer Sensor

## Noisy Electrometer Output

The Electrometer current sensor in the Aerosol Electrometer has an electrical noise level less than 1 fA RMS (at 1 second running average). Such low noise levels require very careful handling to provide sufficient shielding and insulation.

To check the Electrometer noise level, put a HEPA filter at the inlet of the electrometer. Set the flow rate at 2 L/min and wait a few minutes for the particles inside the electrometer to be purged. Then turn off flow by disconnecting electrometer from the external vacuum. Next take current measurement for 2 minutes and record the $N$ current data $I_i$. Use Aerosol Instrument Manager software to show the RMS value (in statistics) or calculate the RMS value of the noise level ($I_{RMS}$) as follows:

$$I_{RMS} = \sqrt{\frac{1}{N} \sum_{i=1}^{N} (I_i - \bar{I})^2}$$

where $\bar{I}$ is the average value of the $N$ current data $I_i$.

If the Electrometer exhibits excessive random noise at zero flow (more than 5 fA RMS), try the following steps:

1. Reset the zero offset of the electrometer and measure the RMS noise again.
2. If the noise persists, check the vibration level of the surface on which the electrometer sits. If the vibration is high, move the electrometer to a stable surface and measure the RMS noise without flow again.

3. If the noise level is still high, the problem is probably a poor electrical connection or an electrical leakage path to ground due to contamination. Wear lint-free gloves and remove the filter cover plate (Refer to the section “Replacing the Filter Cartridge and Cleaning the Electrometer” in Chapter 6). Clean the upper insulator and inlet tube assembly using detergent and water in an ultrasonic cleaner. Rinse with clean water; then rinse with clean reagent-grade alcohol. Air dry and reinstall the upper insulator, using a moderate amount of high-vacuum grease on the O-ring. Do not touch upper insulator with bare fingers after cleaning and do not apply vacuum grease anywhere except to the O-ring. It may take more than 24 hours after cleaning for the stress built up in the insulator to release and the noise to settle down.

Generally, noise that is present only when the flow is on is not an electrometer problem, but rather a problem with fluctuations in the aerosol concentration level. To check this, connect a high-efficiency particle filter to the aerosol sample inlet so that the measured aerosol concentration goes to nearly zero. The noise fluctuations will then normally disappear.

For situations not covered above or if the noise level is still high, contact customer service for assistance (see Chapter 8).

Unstable Zero Offset Level

The 3068B Electrometer design has proven to be very stable. Development tests have typically shown that the drift of offset is within ±2 fA over 24 hours at conditions of 50% RH and 5 °C or 35 °C. The drift of offset is within ±2 fA over 1 hour at 90% RH and 35 °C.

To check the zero offset and its drift, put a HEPA filter at the inlet of the electrometer. Using Aerosol Instrument Manager software, take a two-minute measurement of current with 1 s average and record the $N$ current data $I_i$. View the RMS value calculated in the statistics section or calculate the zero offset $\bar{I}$ as

$$\bar{I} = \frac{\sum_{i=1}^{N} I_i}{N}.$$
Take multiple offset measurements over a certain period (e.g., 1 hour). If the offset does not drift greater than 2 fA over time, simply subtract the offset readings from your measurement values. However, if the offset drifts significantly, follow the diagnostics steps given in the previous section "Noisy Electrometer Output".
This chapter gives directions for contacting people at TSI Incorporated for technical information and directions for returning the Model 3068B Aerosol Electrometer for service.

**Technical Contacts**

- If you have any difficulty setting up or operating the Electrometer, or if you have technical or application questions about this system, contact an applications engineer at TSI Incorporated, 1-800-874-2811 (USA) or (651) 490-2811 or e-mail technical.service@tsi.com.

- If the Electrometer does not operate properly, or if you are returning the instrument for service, visit our website at [http://rma.tsi.com](http://rma.tsi.com), or contact TSI Customer Service at 1-800-874-2811 (USA) or (651) 490-2811.

**Returning the Aerosol Electrometer for Service**

Visit our website at [http://rma.tsi.com](http://rma.tsi.com) or call TSI at 1-800-874-2811 (USA) or (651) 490-2811 for specific return instructions. Customer Service will need this information when you call:

- The instrument model number
- The instrument serial number
- A purchase order number (unless under warranty)
- A billing address
- A shipping address
Use the original packing material to return the instrument to TSI. If you no longer have the original packing material, seal off any ports to prevent debris from entering the instrument and ensure that the display and the connectors on the instrument front and back panels are protected.
# APPENDIX A

## Model 3068B Specifications

The following specifications list the most important features of the Model 3068B Aerosol Electrometer.

### Table A-1
Specifications* of the 3068B Aerosol Electrometer

<table>
<thead>
<tr>
<th>Specification</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Mode of operation</strong></td>
<td>Measure particle concentration by measuring the current induced by charged particles collected on a filter</td>
</tr>
<tr>
<td><strong>Measurement range</strong></td>
<td>±12.5 pA</td>
</tr>
<tr>
<td><strong>Particle type</strong></td>
<td>Solids and nonvolatile liquids</td>
</tr>
<tr>
<td><strong>Current accuracy</strong></td>
<td>±2% of reading or ±5 fA, whichever is greater</td>
</tr>
<tr>
<td><strong>Noise</strong></td>
<td>&lt; 1 fA RMS at 1 s average</td>
</tr>
<tr>
<td><strong>Drift/Stability</strong></td>
<td>±2 fA at an average of 1 s over 24 hours at environmental conditions of 5°C and 50% RH and 35°C and 50% RH; ±2 fA at an average of 1 s over 1 hour at environmental conditions of 35°C and 90% RH</td>
</tr>
<tr>
<td><strong>Linearity error</strong></td>
<td>&lt; 1% of reading</td>
</tr>
<tr>
<td><strong>Data dynamic range</strong></td>
<td>±12.5 pA</td>
</tr>
<tr>
<td><strong>Maximum data rate</strong></td>
<td>1 Hz</td>
</tr>
<tr>
<td><strong>Warm-up time</strong></td>
<td>Settle to ±2 fA within 10 minutes</td>
</tr>
<tr>
<td><strong>Step response time</strong></td>
<td>2.5 s 0-90% of final value at 1 s average</td>
</tr>
<tr>
<td><strong>Flow rate</strong></td>
<td>Programmable from 0.3 to 2 L/min (±2%) and 2.0 to 10 L/min (±5%) at 101.3kPa and 20°C</td>
</tr>
<tr>
<td><strong>Aerosol temperature range</strong></td>
<td>5 to 35°C</td>
</tr>
<tr>
<td><strong>Aerosol pressure range</strong></td>
<td>From 25% below to 25% above atmosphere pressure</td>
</tr>
<tr>
<td><strong>Particle size range</strong></td>
<td>2 to 5000 nm</td>
</tr>
<tr>
<td><strong>Front panel display</strong></td>
<td>2-line and 16-Character Alphanumeric display</td>
</tr>
<tr>
<td><strong>Dimensions (LWH)</strong></td>
<td>30.4 cm × 21.3 cm × 19.6 cm (12 in. × 8.4 in. × 7.7 in.)</td>
</tr>
<tr>
<td><strong>Weight</strong></td>
<td>4.5 kg (9.9 lb)</td>
</tr>
</tbody>
</table>

(continued on next page)
Table A-1
Specifications* of the 3068B Aerosol Electrometer (continued)

<table>
<thead>
<tr>
<th>Outputs</th>
<th>BNC (0-10V)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configurable analog</td>
<td>DSUB 9-pin RS-232 and USB B</td>
</tr>
<tr>
<td>Digital I/O</td>
<td>series</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Ports</th>
<th>BNC (0-10V)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample Inlet</td>
<td>¼-in. OD tube</td>
</tr>
<tr>
<td>External Vacuum</td>
<td>¼-in. OD tube</td>
</tr>
</tbody>
</table>

| Power requirements     | 100 to 240 VAC, 50/60 Hz, 60W maximum |

<table>
<thead>
<tr>
<th>Environmental conditions</th>
<th>Indoor use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Altitude up to 3000 m (10,000 ft)</td>
<td>Indoor use</td>
</tr>
<tr>
<td>Ambient temperature 10°–35°C (Operates in a CE safe manner from 5°–40°C)</td>
<td>Indoor use</td>
</tr>
<tr>
<td>Ambient humidity 0–90% RH non-condensing</td>
<td>Indoor use</td>
</tr>
<tr>
<td>Over-voltage category II</td>
<td>Indoor use</td>
</tr>
<tr>
<td>Pollution degree II</td>
<td>Indoor use</td>
</tr>
</tbody>
</table>

*Specifications are subject to change without notice. TSI and the TSI logo are registered trademarks of TSI Incorporated.
How the Aerosol Electrometer Operates

The Model 3068B Aerosol Electrometer consists of a Faraday cup and an electrometer (Figure B-1). Particles in the sample flow are collected in a high efficiency conductive filter housed in a metal enclosure, the whole constituting a “Faraday cup”. The metal housing shields the Electrometer input from stray electric fields. This filter is isolated from the metal housing but connected to the ground through an Electrometer current sensor. Electrons will move from the ground to the filter to neutralize the collected particles if they are positively charged, and vise-versa if particles are negatively charged. The current measured by the electrometer current sensor is proportional to the charge collection rate on the filter. The particle number concentration can be calculated from the current if the number of charges on each particle and the aerosol flow rate are known.

![Figure B-1 Principle of an Aerosol Electrometer](image-url)
System Description

Figure B-2 shows a schematic diagram of the Model 3068B Aerosol Electrometer. Charged aerosol enters the instrument through an outer metal housing which shields the Electrometer input from stray electric fields. An absolute filter removes the charged particles from the air stream. The filter is enclosed in an inner metal housing and insulated from the outer metal housing. A signal feedthrough connects the filter to the input of a solid-state electrometer amplifier. The Electrometer has an analog output voltage range of 0 to 10 volts, corresponding to a maximum current range of -12.5 to +12.5 picoamperes. The RMS noise current of the Electrometer is less than 1 femptoamp (1 × 10⁻¹⁵ amperes) with a one second averaging time.

The current $I$ (A) measured by the Electrometer is related to the input aerosol concentration $N$ (particle/cm³) by equation (1):

$$I = N \cdot n_p \cdot e \cdot q_e$$  \hspace{1cm} (1)

where $n_p$ is the average number of elementary charge units per particle, $e = 1.6 \times 10^{-19}$ coulomb is the elementary unit of charge, and $q_e$ (cm³/s) is the volumetric aerosol flow rate into the Electrometer filter. When the average number of elementary charge units per particle is known, the aerosol concentration can be calculated from equation (1). The current measurement accuracy of the Model 3068B Aerosol Electrometer is ±2% of the reading or ±5 femptoamp, whichever is greater.

The user specified flow rate (either through key-pad or computer) is achieved through an internal proportional solenoid valve and measured by a TSI Model 4140 Thermal Mass Flowmeter. An external vacuum source should be connected to the External Vacuum port on the back panel of the instrument to drive the flow.
Selected References

The following list contains papers that apply directly to the Aerosol Electrometer as well as other references that may be interesting to the reader.

1. Agarwal JK and GJ Sem [1978]
   “Generating Submicron Monodisperse Aerosols for Instrument Calibration”
   *TSI Quarterly, Vol. IV, No. 2, TSI Incorporated, 500 Cardigan Road, Shoreview, MN. 55126.*

2. Liu BYH and DYH Pui [1975]
   “On the Performance of the Electrical Aerosol Analyzer”
   *J. Aerosol Sci.* 6, 249–264.
3. Liu BYH and DYH Pui [1974]
“A Submicron Aerosol Standard and the Primary, Absolute Calibration of the Condensation Nuclei Counter”
*J. Colloid Interface Sci.* **47**, 155–171.

4. Liu BYH and DYH Pui [1977]
“On Unipolar Diffusion Charging of Aerosols in the Continuum Regime”
*J. Colloid Interface Sci.* **58**, 142.

5. Liu BYH and KW Lee [1975]
“An Aerosol Generator of High Stability”

“Efficiency of Membrane and Nuclepore Filters for Submicrometer Aerosols”

7. Liu BYH and GA Kuhlmey [1977]
“Efficiency of Air Sampling Filter Media in *X-Ray Fluorescence Analysis of Environmental Samples*”

8. Pui DYH [1976]
“Experimental Study of Diffusion Charging of Aerosols”
*Ph.D. Thesis*, Mechanical Engineering Department, University of Minnesota, Minneapolis, Minnesota.

“Design and Application of An Electrical Size Analyzer for Submicron Aerosol Particles”

10. Sinclair D, RJ Countess, BYH Liu and DYH Pui [1979]
“Automatic Analysis of Submicron Aerosols”
Chapter in *Aerosol Measurement*

“An Ultrafine Aerosol Condensation Nucleus Counter”
12. Sverdrup GM [1977]  
“Parametric Measurement of Submicron Atmospheric Aerosol Size Distribution”  
Ph.D. Thesis, Mechanical Engineering Department, University of Minnesota, Minneapolis, Minnesota.
Characterizing Lower Counting Limit

Condensation Particle Counters (CPCs) are characterized by their lower counting limit (smallest particles detected). This is typically not a single value but an efficiency curve. The CPC counting efficiency curve can be obtained by taking the concentration ratio of the CPC to the electrometer measuring the same aerosol side by side for a series of particle sizes.

A typical CPC calibration setup is shown in Figure C-1. Test aerosols are generated using a particle generation instrument. Depending on the test aerosol material and size range, the particle generation instrument can be a TSI Model 3480 Electrospray Aerosol Generator, a TSI Model 3076 Constant Output Atomizer, or a tube furnace. The polydisperse aerosol from the generator first passes through a dilution bridge, which controls the aerosol concentration. Next the differential mobility analyzer (DMA) and the classifier select particles of a given mobility diameter. The sheath to aerosol flow ratio of the DMA is typically set at 10:1 to ensure a narrow “monodisperse” size distribution. Filtered makeup flow is added downstream of the DMA to maintain a flow balance. A mixing orifice is used to enhance the turbulent mixing and ensure uniform aerosol concentration. The aerosol flow then splits to the test CPC and the Aerosol Electrometer. Although only one test CPC is shown in this setup, multiple CPCs can be tested at the same time.

Because the DMA classifies particles according to their electrical mobilities, a small fraction of multiple-charged particles of larger
sizes will pass through the DMA with singly charged particles of the set size. The multiple-charged particles will cause experimental error not only because these particles are larger than the set size, but also the electrometer detects them as multiple particles of one charge. One rigorous way to correct the experimental error due to multiple charging is to carry out a Tandem Differential Mobility Analysis (TDMA) experiment to determine the fraction of multiply charged particles and correct the efficiency data. One simpler way to minimize the multiple charging effects is to sample the test “monodisperse” aerosol from the right-hand side of the mode of the polydisperse aerosol from the generator. In that case, the polydisperse particle size distribution is first scanned with the DMA connected to a reference CPC (i.e., a SMPS system). And then the DMA voltage is set to select the test aerosol from the right-hand side of the size distribution.

Particle concentration needs to be controlled in a proper range during CPC calibration. If the particle concentration is too high, the CPC will have large coincidence error. If the particle concentration is too low, the electrometer will have low signal-to-noise ratio. Therefore, it is a good practice to choose an intermediate concentration that has relatively low CPC coincidence error and statistically significant electrometer signal. Note that the indicated CPC concentration should be corrected for coincidence error, and the electrometer reading should be corrected for zero offset.

In order to keep the particle diffusional losses the same, different flow paths need to be symmetrical, i.e., to keep the flow rates and tube lengths from the flow splitter to the CPC/Electrometer inlet the same. However, if the particle concentration is low or the electrometer noise is high, the electrometer can run at a higher flow rate to increase the signal. In that case, the tube length from the flow splitter to the electrometer should be increased proportionally. Otherwise, diffusion losses due to different flow rates should be corrected in the efficiency calculation.

When particles are in the sub-10 nm range, particles exiting the DMA have a wider size distribution due to diffusion broadening. A rigorous CPC calibration needs to carry out data inversion to account for this broadening effect. Refer to the paper by Stolzenburg and McMurry (see Appendix B) for more details.

As an example, the counting efficiency curve of the Model 3772 CPC is shown in Figure C-2.
Figure C-1
Experimental Setup for CPC Calibration

Figure C-2
Counting Efficiency Curve of the Model 3772 CPC
Characterizing Concentration Linearity

Condensation Particle Counters (CPCs) are also characterized by the linearity of their response to an increase in concentration from zero to the limit of the counter using the electrometer as the reference. Ideally, the slope of the response curve would be 1:1 throughout the concentration range for large particles that are fully activated in the CPC and with negligible diffusional losses. In reality, the slope might deviate due to particle losses, small particles failing to activate, and/or coincidence error.

The experimental setup for linearity test is the same as that in Figure C-1. The DMA is used to select a particle size that lies in the flat portion of the counting efficiency curve (larger size end). Particle concentration is increased from low concentration to the concentration limit of the CPC with incremental steps of ~2000 particle/cm³ by adjusting the dilution bridge. The CPC concentration linearity is obtained by fitting the experimental data (with CPC concentration in y axis and electrometer concentration in x axis) to a straight line.

Figure C-3 shows an example of the Model 3772 CPC linearity result. The data was taken with 40 nm sucrose particles.

![Figure C-3](image)

Figure C-3
Concentration Linearity Result of the Model 3772 CPC
This section is for advanced users that need to communicate with the Model 3068B for advanced calibration, troubleshooting, or diagnostics.

<table>
<thead>
<tr>
<th>Caution</th>
</tr>
</thead>
<tbody>
<tr>
<td>This section is written for technicians. Accessing or changing settings using serial commands can invalidate the calibration or possibly cause damage to the instrument.</td>
</tr>
</tbody>
</table>

**Pin Connectors**

The Model 3068B has a single 9-pin, D-subminiature connector port on the back panel. The communication port is configured at the factory to work with RS-232 type devices.

Table D-1 lists the signal connections.

<table>
<thead>
<tr>
<th>Pin Number</th>
<th>RS-232 Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>—</td>
</tr>
<tr>
<td>2</td>
<td>Transmit Output</td>
</tr>
<tr>
<td>3</td>
<td>Receive Input</td>
</tr>
<tr>
<td>4</td>
<td>(Reserved)</td>
</tr>
<tr>
<td>5</td>
<td>GND</td>
</tr>
<tr>
<td>6</td>
<td>—</td>
</tr>
<tr>
<td>7</td>
<td>—</td>
</tr>
<tr>
<td>8</td>
<td>—</td>
</tr>
<tr>
<td>9</td>
<td>—</td>
</tr>
</tbody>
</table>
**Serial Protocol**

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Baud Rate</td>
<td>115,200</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Parity</td>
<td>None</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
<tr>
<td>Handshaking</td>
<td>None</td>
</tr>
</tbody>
</table>

**Serial Commands**

To communicate with the Model 3068B requires a terminal program. The HyperTerminal program that is included as part of Windows XP is satisfactory. Connect to the Model 3068B as follows:

1. Open the HyperTerminal program by selecting:  
   **Start | Programs | Accessories | Communications | HyperTerminal**.

2. Enter a name for the connection, for example, TSI-3068B.

![Figure D-1](image)

**Figure D-1**
Connection Description

3. Enter the communications (COM) port
4. Enter the port settings described below and click **OK**.

5. Open **File > Properties**. Under the settings tab on the Property window, pick the **ASCII Setup** button and check the boxes...
shown below. Click **OK** to close both ASCII Setup and Properties windows.

![ASCII Setup](image)

**Figure D-4**
ASCII Setup

6. Now select **File | Save As** and save the file to the desktop for easy access.

7. Close the program and start it again from the desktop. It should automatically open a connection to the instrument.

To obtain a complete list of the serial commands, follow the next steps:

1. Type **HELP** in the Hyper Terminal window for a list of commands. The commands are case insensitive.
2. Select **Transfer | Capture Text**.

3. Define a file name and directory to store the serial command list and hit Start.

4. Type **HELP, ALL** in the terminal window and hit Enter.

5. Select **Transfer | Capture Text | Stop**. The command list is capture in the text file for easy reference.
APPENDIX E

Data Files, Project Files, and Stored Parameters

The Aerosol Instrument Manager stores data in two types of files: data files and project files. This appendix describes those files and the parameters stored in them. In addition, it also describes the parameters stored in the aim.ini file.

Data Files and Project Files

The Aerosol Instrument Manager uses two types of files:

- Data files
- Project files

**Data files** contain sample data. They have a filename extension to indicate the type of sensor from which data was collected, such as .E68 for a Model 3068B Aerosol Electrometer. Other information stored in data files includes:

Information stored for the whole file:

- Number of samples in file
- Instrument Model

Information stored for each sample:

- Instrument ID
- Sample length
- Averaging interval
- Comment
- Sample title
- Time sample started
- Status flags from the instrument
- Sample flow rate
- Average charge per particle
Project files are created by the program when you open a data file and work with it. The project file name is the same as the data file name with the extension “.p68” instead of .E68. Project files keep track of “cosmetic” attributes like which windows are open on the desktop when you close the file and how that information is displayed. This information is recalled the next time you open the data file.

If you transfer data files to someone, you do not need to transfer the project files unless you want to. If you delete a project file, a new project file is created when you reopen the data file.

**Project File Parameters**

The following parameters are saved for each window:

- The graph type (bar, line, or area)
- The grid type shown on the graph (none, vertical, horizontal or both vertical and horizontal)
- Y axis scale parameters
- List type, for the Samples List window
- Position and size of each window

The following parameters apply to the entire file (not to each individual window):

- Playback delay time
- Current sample index (the sample number of the sample you were viewing when you exited the program)
Saved Parameters

The following parameters are stored in the Aerosol Instrument Manager application initialization file (aim.ini):

- Font and color for tables.
- Font and color for graphs.
- Aerosol Instrument Manager main window size and position.
- Scheduling options
- Sample settings such as sample flow rate and average particle charge
- Export options.
APPENDIX F

Accelerator Keys

Accelerator keys are those keys and key combinations that allow you to perform operations using only your keyboard (no mouse required).

These are the accelerator keys that can be used with your sensor.

<table>
<thead>
<tr>
<th>Key(s)</th>
<th>Action for an Aerosol Electrometer</th>
</tr>
</thead>
<tbody>
<tr>
<td>F3</td>
<td>View statistics</td>
</tr>
<tr>
<td>F4</td>
<td>View settings</td>
</tr>
<tr>
<td>Alt B</td>
<td>Go to first sample &quot;Begin&quot;</td>
</tr>
<tr>
<td>Ctrl A</td>
<td>Select all in the Samples List window when the window is active</td>
</tr>
<tr>
<td>Ctrl C</td>
<td>Copy current view to clipboard</td>
</tr>
<tr>
<td>Alt E</td>
<td>Go to last sample &quot;End&quot;</td>
</tr>
<tr>
<td>Alt N</td>
<td>Next sample</td>
</tr>
<tr>
<td>Ctrl N</td>
<td>New document</td>
</tr>
<tr>
<td>Ctrl O</td>
<td>Open a document</td>
</tr>
<tr>
<td>Alt P</td>
<td>Previous sample</td>
</tr>
<tr>
<td>Ctrl P</td>
<td>Print current view</td>
</tr>
<tr>
<td>Z</td>
<td>Undo Zoom</td>
</tr>
<tr>
<td>Ctrl I</td>
<td>Open Instrument Status dialog window</td>
</tr>
<tr>
<td>Ctrl L</td>
<td>Arrange windows in 4-pane layout</td>
</tr>
<tr>
<td>Ctrl R</td>
<td>View Properties</td>
</tr>
</tbody>
</table>
APPENDIX G

Sequence Files

The files for sample sessions that run past midnight (or run for more than 24 hours) are handled differently than those that start and stop on the same date. (Midnight occurs on your system according to the setting of your computer’s system clock.)

For these sample sessions, a sequence of files is created, with each file in the sequence given a unique filename extension identifying its proper order.

Normally, only a single file is created for any sample session and it has a filename extension of the form .E68. For example, Atmosphere.E68 would be identified as a 3068B Aerosol Electrometer file.

If the sample session period runs past midnight, a file is created for each date (day). The samples collected before midnight (including the sample that is running at midnight) are collected in a file with the normal extension, i.e., .E68.

Samples that are collected after midnight are saved in a file with an extension of the form “.1.E68”. (Using the same example as above, the next filename would be “Atmosphere.1.E68.”)

For a very long sample session, a file is created each time the sample session runs past midnight and is indicated by adding a new number to the file extension. Using the previous example, the file following “Atmosphere.1.E68” is “Atmosphere.2.E68” and the next file would be “Atmosphere.3.E68” and so on.

These files contain information to link them when opened and the files can be recalled as if they were a single file. The files may also be selected and opened as individual files.

When you save the samples collected during a sample session that runs past midnight, you provide a filename just as you would for any sample session. You do not provide any extensions. The software automatically adds a file extension.
Opening a File That is Part of a Sequence

If you select **File|Open** and the file is part of a sequence of files (i.e., the sample session ran over midnight), all files in the sequence will be automatically opened.

**Note:** If you select **View|Samples List|Details**, you can see the pathname for each sample.

When you open a sequence of files, the software looks for the first file of that sequence (i.e., the one with the .E68 extension for a Model 3068 Aerosol Electrometer and opens all files in sequence beginning with that file). If a sequence file is unavailable (for example, it has been deleted, moved or corrupted), the software opens the files until it comes to the missing file. For example, if you try to open a sequence of files that contains seven files and the fourth file is missing, only the first three files can be opened. Files five, six, and seven are “orphaned.” These remaining files (5, 6, and 7) can only be opened individually, not as a sequence.
APPENDIX H

Error Messages

This appendix lists the messages you may encounter when using the software and suggests the action you should take.

Table H-1

<table>
<thead>
<tr>
<th>Error Message</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;file&gt; already exists. Do you want to append to it?</td>
<td>The text file selected already exists. New exported data will be appended to the end of the file.</td>
</tr>
<tr>
<td>0 is invalid when using a log y scale.</td>
<td>You must enter a number greater than zero to proceed.</td>
</tr>
<tr>
<td>0 is not valid for the maximum value.</td>
<td>You must enter a number greater than zero to proceed.</td>
</tr>
<tr>
<td>The connected instrument is not an Aerosol Electrometer 3068B.</td>
<td>Verify the type of instrument you are connected to and the file type you opened. For example: If you opened a file of type &quot;*.c75&quot; then it is expected that you will connect to a CPC 3775.</td>
</tr>
<tr>
<td>Cannot communicate with the instrument. Please check that it is connected, turned on, has the correct comm settings set in the properties, and that the port is not in use by another application.</td>
<td>Communications error, the software cannot communicate with the instrument. Please check the items indicated in the message.</td>
</tr>
<tr>
<td>Cannot find a file (&lt;filename&gt;) in the sequence of files associated with &lt;filename&gt;. Only the samples loaded will be available.</td>
<td>Warning to let you know that the sequence of files has a gap and the program cannot load all of the files.</td>
</tr>
<tr>
<td>The connected instrument is not a 3068B.</td>
<td>Verify instrument configuration.</td>
</tr>
<tr>
<td>There is no data remaining.</td>
<td>There is no more data left in the file after samples marked for deletion have been removed.</td>
</tr>
<tr>
<td>Fixed Scale is selected. You must select a Minimum and/or Maximum value.</td>
<td>If you want to use the fixed scale parameter, you must select a minimum or maximum value.</td>
</tr>
<tr>
<td>Log y scale is invalid because the minimum y scale value is set to 0.</td>
<td>You have tried to select log Y scale and you also have 0 as the fixed minimum value. You cannot have both selected. Change one.</td>
</tr>
<tr>
<td>Maximum value must be &gt; minimum value.</td>
<td>You have entered a minimum value that is greater than the maximum value. Reenter the correct values.</td>
</tr>
<tr>
<td>File Missing.</td>
<td>One of the files in a sequence cannot be found.</td>
</tr>
<tr>
<td>Sample #x will be discarded and cannot be recovered. Do you want to discard it?</td>
<td>Answer yes if you want to permanently remove the sample from the file.</td>
</tr>
<tr>
<td>The instrument is reporting: Sample Flow Error; Do you want to start sampling anyway?</td>
<td>Select Yes to start sampling or select No if you do not want to start sampling at this time.</td>
</tr>
<tr>
<td>Unable to read instrument status due to communication error.</td>
<td>Before sampling begins, Aerosol Instrument Manager verifies the status of the instrument. It was unable to read the instrument status.</td>
</tr>
<tr>
<td>Error Message</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>The boundaries range is invalid.</td>
<td>The start time selected for the view boundary cannot exceed the end time.</td>
</tr>
<tr>
<td>You must stop data collection before exiting Aerosol Instrument Manager.</td>
<td>Attempt to exit Aerosol Instrument Manager during a sample run.</td>
</tr>
<tr>
<td>There is no data to be saved.</td>
<td>Attempt to save a file with no sample data.</td>
</tr>
<tr>
<td>The file you have selected is part of a sequence of files. Do you want to view all the files?</td>
<td>You have selected a file that is part of a sequence of files. You can select Yes to view all the files or No to view only the file you initially selected.</td>
</tr>
<tr>
<td>The User Defined inter sample time is less than the sample length.</td>
<td>Properties</td>
</tr>
<tr>
<td>The starting hour is invalid</td>
<td>Properties</td>
</tr>
<tr>
<td>The Hours field cannot be blank.</td>
<td>You must enter a value in this field.</td>
</tr>
<tr>
<td>The Minutes field cannot be blank.</td>
<td>You must enter a value in this field.</td>
</tr>
<tr>
<td>The number of samples cannot be zero.</td>
<td>You must enter a value greater than 0 in this field.</td>
</tr>
<tr>
<td>The sample length cannot be zero.</td>
<td>You must enter a value greater than 0 in this field.</td>
</tr>
<tr>
<td>The Averaging Interval cannot be zero.</td>
<td>You must enter a value greater than 0 in this field.</td>
</tr>
<tr>
<td>The Sample Length should be equal to or greater than the Averaging Interval.</td>
<td>You must enter a sample length equal to or greater than the averaging interval.</td>
</tr>
<tr>
<td>The maximum data points allowed are 28,800. You need to change the value of either the sample length or the averaging interval.</td>
<td>The sample length divided by the averaging interval cannot exceed 28,800.</td>
</tr>
<tr>
<td>The Sample Length should be divisible by the Averaging Interval.</td>
<td>Properties</td>
</tr>
<tr>
<td>The properties for sample #x could not be saved.</td>
<td>Unable to save changed property values for the sample.</td>
</tr>
<tr>
<td>Unable to create the graph control.</td>
<td>Contact TSI for support.</td>
</tr>
<tr>
<td>Unable to start Timer for CPC data collection.</td>
<td>Try to restart Aerosol Instrument Manager. If this message reappears, reinstall Aerosol Instrument Manager. Contact TSI for support.</td>
</tr>
</tbody>
</table>
Index

8
8-hr TWA, 5-41

A
abort current sample, 5-25
about Aerosol Instrument Manager, 5-38
about this manual, xvii
AC power connector, 3-4
AC POWER IN connection, 2-2
accelerator keys, F-1
accessories
   optional, 2-5
active window, xviii
aerosol inlet, 3-5
Aerosol Instrument Manager Software, 5-1, (see also software)
   arrange open windows, 5-12
   change how data is viewed, 5-5
   delete/undelete samples, 5-9
   desktop, 5-3, 5-4
   desktop menus, 5-21
   export data, 5-11
   getting started, 5-3
   installation, 5-2
   installation requirements, 5-1
   instrument properties, 5-14
   menus, 5-20
   opening an existing file, 5-4
   playback data samples, 5-6
   print information displayed on desktop, 5-10
   procedures, 5-14
   quite program, 5-13
   sample data, 5-19
   select data hot spot, 5-8
   starting program, 5-3
   using, 4-4
   zoom in/zoom out, 5-9
aerosol pressure, 4-3
aerosol pressure range, A-1
aerosol source
   connecting, 2-3
aerosol temperature, 4-3
aerosol temperature range, A-1
ambient pressure, 4-3
analog output, 2-4, 3-5
analog output mode, 5-36
analog output scale setting menu, 4-2
application notes, C-1
arrange open windows, 5-12
ASCII setup, D-4
auto export, 5-25
AutoPlay, 5-2
average charge/particle setting menu, 4-2
average particle charge, 5-36
averaging interval, 5-16
avg. particle charge, 5-36

B
back panel, 3-4
beginning sample, 5-37

C
cabinet temperature, 4-3
cable
   power, 4-1
calculated concentration, 5-11
calculated particle concentration, 1-3
calibration, 6-1
cautions, xiii
description, xv
descriptions, 5-19
symbol, xv, xvi
chamber cover screws, 6-2
change how data is viewed, 5-5
characterizing concentration linearity, C-4
characterizing lower counting limit, C-1
checking flowmeter, 6-4
classifier, C-1
cleaning, 6-2
collecting sample data, 5-19
color, 5-29, 5-41, 5-43
color and font toolbar, 5-36
commands, serial, D-1
communications error dialog box, 5-20
communications tab, 5-18
   descriptions, 5-19
   properties dialog box, 5-18
computer
   connecting, 2-4
   computer control, 4-4
concentration linearity result of 3772, C-4
configurable analog output, A-2
configure user settings, 4-2
connect to a serial port
dialog box, D-3
connect to instrument, 5-25
connecting
   aerosol source, 2-3
   computer, 2-4
connecting (continued)
  vacuum, 2-3
connection description, D-2
connectors, 3-1
contacting TSI, 8-1
  email address, v
  getting help, xix
  submitting comments, xix
context-sensitive menus, 5-38
controls, 3-1
copy, 5-35, 5-41, 5-43
count accuracy, A-1
counting efficiency curve of 3772, C-3
CPC
  properties, 5-14
  USB port, 5-2
current zero offset, 4-4
customer service, 8-1

data average time setting menu, 4-3
data dynamic range, A-1
data files, E-1
data hotspot, select, 5-8
data table, 5-33
delete/undelete sample, 5-9, 5-37
description of system, B-2
desktop, 5-3
  menus, 5-21
differential mobility analyzer, C-1
digital I/O output, A-2
dimensions, A-1
disconnect from instrument, 5-25
display, 3-2
display as, 5-41, 5-42
display selected samples, 5-39, 5-40
drift/stability, A-1

electrometer current, 1-3, 5-11
Electrostatic Classifier, 1-1
ending sample, 5-37
environmental conditions, A-2
error messages, 7-1, H-1
example files, 5-4
experimental setup for CPC calibration, C-3
export, 5-23, 5-39
export data, 5-11
  automatically, 5-12
  manually, 5-11
export parameters box, 5-11
extensions
  CPC, 5-19
external vacuum, A-2
  connector, 4-1
  tubing, 3-5

F
Faraday cup, B-1
femtoAmp, 1-2
file menu, 5-21
  close, 5-22
  exit, 5-24
  export, 5-23
  import, 5-23
  list of recently accessed files, 5-24
  new, 5-21
  open, 5-22
  print, 5-23
  print preview, 5-23
  print setup, 5-24
  properties, 5-23
  save, 5-22
  save as, 5-23
file menu options screen, 5-21
file parameters, E-1
filter, 6-3
filter access cover, 3-6
filter cartridge
  replacing, 6-2
finish current sample, 5-25
firmware version, 4-4
flat cable
  location, 7-2
flow control, 5-36
flow control menu, 4-2
flow rate, A-1
Flow Ratio light
  troubleshooting, 7-1
flow set point, 5-36
flow setting menu, 4-2
flowmeter
  checking, 6-4
font, 5-31, 5-41, 5-43
font dialog box, 5-31
format menu, 5-27, 5-41
  color, 5-29
  font, 5-31
  graph type, 5-28
  grid lines, 5-29
  screen, 5-27
  undo zoom, 5-31
  view boundaries, 5-28
Y-axis, 5-27
front panel, 3-1
  controls, 4-1
  display, A-1
  indicator lights, 3-3

G
getting started, 5-3
graph, 5-32
graph color dialog box, 5-30
graph toolbar, 5-36
graph type, 5-28
graph view
  popup menu, 5-41
  display as, 5-42
  popup menu dialog box, 5-41
graph view popup menu, 5-5
graph view showing calculated concentration, 5-42
grid lines, 5-29, 5-41

H
help, xix, 8-1
help commands list, D-5
help manual, 5-38
help menu, 5-38
  dialog box, 5-38
HEPA filter, 4-3

I–J
icons
  playback, 5-7
  status bar, 5-43
import, 5-23
indicator lights, 3-3
indicators, 3-1
instrument status
  dialog box, 5-35
insulator, 6-3
isolating leaks, 6-5

K
keypad, 3-2

L
LabVIEW™ software, 4-4
leaks
  isolating, 6-5
  testing for, 6-4
lights. (see indicator lights)
linearity error, A-1
list of recently accessed files, 5-24

M
maintenance, 6-1
  schedule, 6-1
manual
  history, iv
  notations/conventions, xviii
  organization, xvii
manual flow setting, 5-17
mark samples for deletion, 5-9
maximum data rate, A-1
menu navigation, 3-2
menu structure, 3-2
menus
  software, 5-20
mode of operation, A-1
Model 3033 Vacuum Pump, 4-1
Model 3076 Constant Output Atomizer, C-1
Model 3080 Electrostatic Classifier, 1-1
  manual, xviii
Model 3480 Electrospray Aerosol Generator, C-1
Model 3772/3771 Condensation Particle Counter
  manual, xviii
Model 3775 Condensation Particle Counter
  manual, xviii
Model 3776 Ultrafine Particle Counter
  manual, xviii
  monodisperse, C-1
  mounting instrument, 2-2
  moving instrument, 2-2

N
navigation, 1-2
navigation path, 3-2
navigation toolbar, 5-36
next sample, 5-37
noise, A-1
noisy output, 7-2
notations/conventions, xviii
number of samples, 5-15

O
offset, 5-18
on/off switch, 3-4
open an existing file, 5-4
operation, 4-1
optional accessories, 2-5
organization
  manual, xvii
outputs, A-2

P
packing instructions, 8-2
packing list, 2-1
particle size range, A-1
particle type, A-1
pause, 5-7, 5-26
performance, 6-1
pin connectors, D-1
play, 5-26
play continuous, 5-26
play once, 5-26
playback data samples, 5-6
playback icons, 5-7
playback menu, 5-26
  pause, 5-26
  play, 5-26
  screen, 5-26
  stop, 5-26
playback setup dialog box, 5-7
polydisperse aerosol, C-1
popup menus, 5-39
port settings, D-3
ports, A-2

Index–3
power
cable, 4-1
connection, 2-2
cord inlet, 4-1
requirements, A-2
power light, 3-3
preview, print, 5-10
previous sample, 5-37
principle of aerosol electrometer, B-1
print, 5-41, 5-43
print information displayed, 5-10
print preview, 5-23, 5-41, 5-43
screen, 5-10
print setup, 5-24
product description, 1-1
product overview, 1-1
software, 1-2
project files, E-1
properties, 5-25, 5-39
protective caps, 2-1
purpose of manual, xvii

Q
quit the program, 5-13

R
reader's comments (Reader's Comments Sheet)
README.TXT file, 5-2
references, B-3
replacing filter cartridge, 6-2
returning for service, 8-1
root mean square, 1-2
RS-232, 3-4
serial interface port, 5-2
run menu, 5-24
abort current sample, 5-25
auto export, 5-25
connect to instrument, 5-25
disconnect from instrument, 5-25
finish current sample, 5-25
instrument status, 5-35
properties, 5-25
screen, 5-24
start data collection, 5-24
stop current sample, 5-25

S
safety, xiii
cautions symbol, xv
cap, xiii
descriptions, xiii
descriptions (see also Aerosol Instrument Manager Software)
safety, xiii
caution symbol, xv
labels, xiii
descriptions, xiii
descriptions (see also Aerosol Instrument Manager Software)
safety, xiii
cautions symbol, xv
labels, xiii
descriptions, xiii
descriptions (see also Aerosol Instrument Manager Software)
safety, xiii
cautions symbol, xv
labels, xiii
descriptions, xiii
descriptions (see also Aerosol Instrument Manager Software)
safety, xiii
cautions symbol, xv
labels, xiii
descriptions, xiii
descriptions (see also Aerosol Instrument Manager Software)
safety, xiii
cautions symbol, xv
labels, xiii
descriptions, xiii
descriptions (see also Aerosol Instrument Manager Software)
safety, xiii
cautions symbol, xv
labels, xiii
descriptions, xiii
descriptions (see also Aerosol Instrument Manager Software)
safety, xiii
cautions symbol, xv
labels, xiii
descriptions, xiii
descriptions (see also Aerosol Instrument Manager Software)
safety, xiii
cautions symbol, xv
labels, xiii
descriptions, xiii
descriptions (see also Aerosol Instrument Manager Software)
safety, xiii
cautions symbol, xv
labels, xiii
descriptions, xiii
descriptions (see also Aerosol Instrument Manager Software)
safety, xiii
cautions symbol, xv
labels, xiii
descriptions, xiii
descriptions (see also Aerosol Instrument Manager Software)
safety, xiii
cautions symbol, xv
labels, xiii
descriptions, xiii
descriptions (see also Aerosol Instrument Manager Software)
safety, xiii
cautions symbol, xv
labels, xiii
descriptions, xiii
descriptions (see also Aerosol Instrument Manager Software)
safety, xiii
cautions symbol, xv
labels, xiii
descriptions, xiii
descriptions (see also Aerosol Instrument Manager Software)
safety, xiii
cautions symbol, xv
labels, xiii
descriptions, xiii
descriptions (see also Aerosol Instrument Manager Software)
safety, xiii
cautions symbol, xv
labels, xiii
descriptions, xiii
descriptions (see also Aerosol Instrument Manager Software)
safety, xiii
cautions symbol, xv
labels, xiii
descriptions, xiii
descriptions (see also Aerosol Instrument Manager Software)
safety, xiii
cautions symbol, xv
labels, xiii
descriptions, xiii
descriptions (see also Aerosol Instrument Manager Software)
safety, xiii
cautions symbol, xv
labels, xiii
descriptions, xiii
descriptions (see also Aerosol Instrument Manager Software)
safety, xiii
cautions symbol, xv
labels, xiii
descriptions, xiii
descriptions (see also Aerosol Instrument Manager Software)
safety, xiii
cautions symbol, xv
labels, xiii
descriptions, xiii
descriptions (see also Aerosol Instrument Manager Software)
safety, xiii
cautions symbol, xv
labels, xiii
descriptions, xiii
descriptions (see also Aerosol Instrument Manager Software)
safety, xiii
cautions symbol, xv
labels, xiii
descriptions, xiii
descriptions (see also Aerosol Instrument Manager Software)
safety, xiii
cautions symbol, xv
labels, xiii
descriptions, xiii
descriptions (see also Aerosol Instrument Manager Software)
safety, xiii
cautions symbol, xv
labels, xiii
descriptions, xiii
descriptions (see also Aerosol Instrument Manager Software)
safety, xiii
cautions symbol, xv
labels, xiii
descriptions, xiii
descriptions (see also Aerosol Instrument Manager Software)
safety, xiii
cautions symbol, xv
labels, xiii
descriptions, xiii
descriptions (see also Aerosol Instrument Manager Software)
safety, xiii
cautions symbol, xv
labels, xiii
descriptions, xiii
descriptions (see also Aerosol Instrument Manager Software)
safety, xiii
cautions symbol, xv
labels, xiii
descriptions, xiii
descriptions (see also Aerosol Instrument Manager Software)
safety, xiii
cautions symbol, xv
labels, xiii
descriptions, xiii
descriptions (see also Aerosol Instrument Manager Software)
safety, xiii
cautions symbol, xv
labels, xiii
descriptions, xiii
descriptions (see also Aerosol Instrument Manager Software)
safety, xiii
cautions symbol, xv
labels, xiii
descriptions, xiii
descriptions (see also Aerosol Instrument Manager Software)
safety, xiii
cautions symbol, xv
labels, xiii
descriptions, xiii
descriptions (see also Aerosol Instrument Manager Software)
safety, xiii
cautions symbol, xv
labels, xiii
descriptions, xiii
descriptions (see also Aerosol Instrument Manager Software)
safety, xiii
cautions symbol, xv
labels, xiii
descriptions, xiii
descriptions (see also Aerosol Instrument Manager Software)
safety, xiii
cautions symbol, xv
labels, xiii
descriptions, xiii
descriptions (see also Aerosol Instrument Manager Software)
safety, xiii
cautions symbol, xv
labels, xiii
descriptions, xiii
descriptions (see also Aerosol Instrument Manager Software)
safety, xiii
cautions symbol, xv
labels, xiii
descriptions, xiii
descriptions (see also Aerosol Instrument Manager Software)
safety, xiii
cautions symbol, xv
labels, xiii
descriptions, xiii
descriptions (see also Aerosol Instrument Manager Software)
safety, xiii
cautions symbol, xv
labels, xiii
descriptions, xiii
descriptions (see also Aerosol Instrument Manager Software)
safety, xiii
cautions symbol, xv
labels, xiii
descriptions, xiii
descriptions (see also Aerosol Instrument Manager Software)
safety, xiii
cautions symbol, xv
labels, xiii
descriptions, xiii
descriptions (see also Aerosol Instrument Manager Software)
safety, xiii
cautions symbol, xv
labels, xiii
descriptions, xiii
descriptions (see also Aerosol Instrument Manager Software)

software (continued)
  menus, 5-20
  other, 4-4
  procedures, 5-14
  starting program, 5-3
  Visual Basic®, 4-4
  specifications, A-1
  spring wire, 6-3
  start, 5-7
  start at time, 5-16
  start data collection, 5-24
  start measurement, 4-1
  start the program, 5-3
  statistics, 5-34
    screen, 5-34
  statistics popup menu, 5-42
  statistics view
    popup menu, 5-43
    popup menu dialog box, 5-42
  status bar icons, 5-43
  status light, 3-3, (see also indicator lights)
  status viewing menu, 4-3
  stop, 5-7, 5-26
  stop current sample, 5-25
  supplying power, 4-1

T
  table, 5-32
    screen, 5-33
  table color dialog box, 5-30
  table view
    popup menu, 5-40, 5-41
    popup menu dialog box, 5-40
  tandem differential mobility analysis, C-2
  technical contacts, 8-1
  testing for leaks, 6-4
  theory of operation, B-1
  toolbars, 5-36
  total flow light
    troubleshooting, 7-1
  total sample time, 5-15
  troubleshooting, 7-1
  tube furnace, C-1
  two-panel layout of aerosol electrometer file, 5-13

U
  undelete/delete samples, 5-9
  undo zoom, 5-31, 5-41
  unpacking, 2-1
  unstable zero offset level, 7-3
  USB port, 3-4, 5-2
    location, 2-4
  USB status, 4-4
  user setting menu, 4-2

V
  vacuum
    connecting, 2-3
    source, 4-1
  valve duty cycle, 4-3
  view another sample in same file, 5-6
  view boundaries, 5-28, 5-41
  view data values, 5-8
  view instrument status, 4-3
  view menu, 5-32
    copy, 5-35
    graph, 5-32
    screen, 5-32
    settings, 5-34
    statistics, 5-34
    table, 5-32
    toolbars, 5-36
  view user settings, 4-2
  Visual Basic® software, 4-4

W-X
  warm-up time, A-1
  warning, xiii
    description, xv
    symbol, xvi
  warranty, v
  weight, A-1
  window menu, 5-37
    dialog box, 5-38

Y
  y-axis dialog box, 5-28

Z
  zero offset level
    unstable, 7-3
  zero offset reset menu, 4-3
  zero the electrometer, 5-36
  zoom in/zoom out, 5-9
Reader’s Comments Sheet

Please help us improve our manuals by completing and returning this questionnaire to the address listed in the “About This Manual” section or e-mail your comments to particle@tsi.com. Feel free to attach a separate sheet of comments.

**Manual Title**: Model 3068B Aerosol Electrometer    **P/N**: 1930077  **Rev**: A

1. Was the manual easy to understand and use?
   - [ ] Yes  
   - [ ] No

Please identify any problem area(s) ____________________________________________________________
_______________________________________________________________________________________________

2. Was there any incorrect or missing information? (please explain) ________________________________
_______________________________________________________________________________________________

3. Please rate the manual according to the following features:

<table>
<thead>
<tr>
<th>Feature</th>
<th>Good</th>
<th>Adequate</th>
<th>Poor</th>
</tr>
</thead>
<tbody>
<tr>
<td>Readability</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Accuracy</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Completeness (is everything there?)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Organization (finding what you need)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Quality and number of illustrations</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Quality and number of examples</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Comments: ___________________________________________________________________________________
_______________________________________________________________________________________________

4. Which part(s) of this manual did you find most helpful? ________________________________
_______________________________________________________________________________________________
_______________________________________________________________________________________________

5. Rate your level of experience with the product:
   - [ ] Beginning  
   - [ ] Intermediate  
   - [ ] Expert

6. Please provide us with the following information:

   Name ____________________________    Address______________________________
   Title ____________________________    ________________________________
   Company __________________________    ________________________________